Installation Guide

SAP NetWeaver Composition Environment 7.1 SR5 on Linux: SAP MaxDB

Production Edition

Target Audience

- Technology consultants
- System administrators

Document version: 1.1 - 05/16/2008
Document History

⚠️ Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at [http://www.sdn.sap.com/irj/sdn/nw-ce](http://www.sdn.sap.com/irj/sdn/nw-ce).

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>5/16/2008</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>
## Table of Contents

**Chapter 1**

1. Introduction .................................................. 7
   1.1 How to Use This Guide .................................. 7
   1.2 New Features ........................................... 8
   1.3 SAP Notes for the Installation ......................... 10
   1.4 Online Information from SAP .......................... 11
   1.5 Accessing the SAP Library .............................. 12
   1.6 Naming Conventions .................................. 13

**Chapter 2**

2. Planning ...................................................... 15
   2.1 Installation Options Covered by this Guide .......... 15
   2.1.1 Standard System .................................... 16
   2.1.2 Distributed System .................................. 16
   2.1.3 High-Availability System ............................ 17
   2.1.4 Additional Application Server Instance .......... 18
   2.1.5 Standalone Host Agent ............................... 21
   2.2 Distribution of Components to Disks ................. 22
   2.3 SAP MaxDB System Configuration ...................... 25
   2.4 SAP System Transport Host ............................. 26
   2.5 Running Adobe Document Services on Non-supported Platforms .... 27
   2.6 Integration of LDAP Directory Services ............. 27
   2.7 Installation of Multiple Components in One Database .. 31
   2.8 Planning the Switchover Cluster ..................... 33

**Chapter 3**

3. Preparation .................................................. 37
   3.1 Basic SAP System Parameters .......................... 38
   3.2 Hardware and Software Requirements .................. 45
   3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional) ... 47
   3.2.2 Requirements for Linux .............................. 48
   3.2.3 Requirements for a Standard System ............... 49
   3.2.4 Requirements for a Distributed System ............. 50
   3.2.4.1 Requirements for a Central Services Instance ..... 51
   3.2.4.2 Requirements for the Database Instance ......... 51
   3.2.4.3 Requirements for the Primary Application Server Instance ...... 52
   3.2.5 Requirements for a High Availability System ... 53
   3.2.5.1 Requirements for a Central Services Instance .... 53
3.2.5.2 Requirements for an Enqueue Replication Server Instance .......................... 54
3.2.5.3 Requirements for the Database Instance .................................................. 55
3.2.5.4 Requirements for the Primary Application Server Instance ...................... 56
3.2.6 Requirements for an Additional Application Server Instance .................. 57
3.2.7 Requirements for a Standalone Host Agent ................................................ 58
3.2.8 Checking and Modifying the Linux Kernel ............................................... 59
3.2.9 Setting up Swap Space for Linux ............................................................ 59
3.3 Specifying the Virtual Host Name ............................................................... 89
3.4 Performing Switchover Preparations for High Availability ......................... 60
3.5 Creating Operating System Users and Groups ............................................ 61
3.5.1 Creating Linux Groups and Users (Optional) ........................................... 63
3.6 Preparing User Management for an External ABAP System ....................... 63
3.7 Setting Up File Systems and Raw Devices ................................................. 66
3.7.1 SAP Directories ......................................................................................... 67
3.7.2 SAP MaxDB Directories ............................................................................ 71
3.7.3 Host Agent Directories ............................................................................... 71
3.7.4 Setting Up File Systems for a High-Availability System ......................... 72
3.7.5 Configuring Network File System for a High-Availability System ............ 74
3.7.6 Setting Up Standard File Systems and Raw Devices for Linux ............... 76
3.8 Exporting and Mounting the Global Transport Directory ......................... 77
3.9 Exporting and Mounting Directories via NFS for Linux (Optional) ............. 78
3.10 Generating the SAP Solution Manager Key ............................................... 80
3.11 Preparing the Installation DVDs ............................................................... 80

Chapter 4 Installation ....................................................................................... 85
4.1 Exporting and Mounting Global Directories .......................................... 88
4.2 Specifying the Virtual Host Name ........................................................... 89
4.3 Running SAPinst ......................................................................................... 89
4.4 SAPinst Installation Options ..................................................................... 95
4.5 Installing Additional Components (Optional) ....................................... 98
4.6 Installing SAP Memory Analyzer (Optional) ........................................... 100

Chapter 5 Post-Installation ............................................................................. 103
5.1 Logging On to the Application Server ...................................................... 104
5.2 Ensuring User Security ............................................................................ 105
5.3 Installing the SAP License ....................................................................... 107
5.4 Configuring the Transport Management System .................................. 108
5.5 Configuring the Remote Connection to SAP Support ......................... 108
5.6 Applying the Latest Kernel and Support Packages ............................... 109
5.7 High Availability: Setting Up Licenses ............................................... 110
5.8 Installing or Upgrading Database Studio for SAP MaxDB ...................... 111
5.9 Secure Sockets Layer Protocol for Database Server Communication ....... 113
5.9.1 Installing the SAP Cryptographic Library ........................................ 113
5.9.2 Generating the Personal Security Environment ............................... 114
5.10 Backing Up the SAP MaxDB Database ........................................... 117
5.11 Updating the Database Software to the Current Release ................... 117
5.12 Post-Installation Steps for the Host Agent ....................................... 117
5.13 Checking the SAP Java Documentation ........................................... 118
5.14 CE-Specific Post-Installation Activities .......................................... 119
5.15 Performing a Full Installation Backup ............................................ 122
5.16 Post-Installation Steps for the Diagnostics Agent ............................... 124

Chapter 6

Additional Information ........................................................................ 125
6.1 Transporting Self-Developed Software Component Archives (SCA) into the System ......................................................... 125
6.2 Troubleshooting – Repairing an Inconsistent SAP MaxDB Installation ...... 126
6.3 Restarting the SAP MaxDB Server Manually ....................................... 126
6.4 Configuration Templates ................................................................... 127
6.5 Uninstalling SAP NetWeaver Composition Environment .................... 128
6.6 Mounting a CD/DVD for Linux ....................................................... 128
6.7 Heterogeneous SAP System Installation ........................................... 129
6.8 Starting and Stopping SAP System Instances ..................................... 129
6.8.1 Starting and Stopping the SAP System Using the SAP Management Console ................................................................. 129
6.8.2 Starting and Stopping the SAP System Using Scripts ..................... 133
6.8.3 Starting and Stopping the Diagnostics Agent Using Scripts ............. 137
6.9 High Availability: Finalizing the Enqueue Replication Server ............... 138
6.10 Deleting an SAP System ................................................................. 139
1 Introduction

This document explains how to install an SAP NetWeaver Composition Environment system as productive edition.
For more information about SAP NetWeaver Composition Environment, see

Constraints
You need to consider the following constraints before you start your installation:

- You must only use the SAP installation tools according to the instructions and for the purposes described in the SAP installation document. Improper use of the SAP installation tools can damage files and systems already installed.
- SAP system installations should only be performed by SAP Technical Consultants certified for your operating system, your database, and the SAP system that you are installing.
- For downward-compatible releases of DB/OS platforms for SAP products, SAP plans to regularly release the newest database (DB) and operating-system (OS) versions of SAP products. These releases are downward-compatible with earlier SAP system releases.

Note that for already shipped SAP components, we only support the installation for database versions proposed by the installation tool. Therefore, you must install an SAP component or perform a system copy using a downward-compatible database as follows:

- Install the component with the old proposed database version.
- Upgrade the old database version to the downward-compatible new version.

1.1 How to Use This Guide

At the beginning of each installation phase – planning, preparation, installation, and post-installation – you can find a list of the steps that you have to perform in that phase, as well as additional information. Detailed information about the steps for each phase is available in the relevant chapter.

When you plan the installation, you have to decide what exactly you want to install, because the steps within each phase vary according to the installation option you choose.

The following installation options are described in this document:

- Standard system (formerly known as central system)
- Distributed system
1 Introduction
1.2 New Features

Only valid for: HA (UNIX)

- High-availability system

End of: HA (UNIX)

- One or more additional application server instance(s) for an existing standard, distributed, or high-availability system
- Standalone host agent

1.2 New Features

Here you can find the new features in this release.

⚠️ Caution
Make sure that you read the release notes for your SAP system. You can find these at http://service.sap.com/releasenotes.

SAP System Installation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPinst</td>
<td>SAPinst has the following new features:</td>
</tr>
<tr>
<td></td>
<td>- The technical terms used for the instances of an SAP system have changed as follows:</td>
</tr>
</tbody>
</table>
|        |   - “Central instance” (CI) is now called “primary application server instance”.
|        |   - “Dialog instance” (DI) is now called “additional application server instance”.
|        | 🔄 Note  |
|        | The technical terms “Database instance”, “Java central services instance” (SCS). |
|        | - “Central system” – meaning an SAP system running on one single host – is now called “standard system”. |
|        | Only valid for: HA (UNIX) |
|        | - You can now install the enqueue replication server (ERS) with SAPinst. There is a new installation option Enqueue Replication Server Instance available for the installation options Distributed System and High-Availability System. |
|        | End of: HA (UNIX) |
|        | - Host agent |
|        | The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components, except TREX.
|        | The host agent is automatically installed with your SAP system. |
|        | You can also install a standalone host agent with SAPinst. There is a new installation option Host Agent available under Software Life-Cycle Options ➔ Additional Preparations ➔.
<p>|        | You only need to install a standalone host agent in the following cases: |
|        |   - You want to centrally monitor a host that does not have an SAP component. |</p>
<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Deployment Manager (SDM) no longer available in the Application Server Java</td>
<td>The Software Deployment Manager (SDM) is no longer part of the primary application server instance of a Java-only system. Therefore, there is no longer any technical difference between the primary application server instance and the additional application server instance of a Java-only system. The SAP system directory of both instances is now called J&lt;instance_number&gt;. J&lt;instance_number&gt; no longer exists. For more information, see SAP Directories [page 67].</td>
</tr>
<tr>
<td>Installation DVDs</td>
<td>You start the installation from the Installation Master DVD for your database.</td>
</tr>
<tr>
<td>Java Library</td>
<td>There is no longer a Java library for Java systems. Everything is now in the kernel. You no longer need APYJ2EELIB and RMVJ2EELIB.</td>
</tr>
<tr>
<td>SAP Java Virtual Machine (SAP JVM)</td>
<td>You no longer have to download and install a Java Development Kit (JDK) from another software vendor as a prerequisite for the installation with SAPinst. The SAP JVM is a Java Development Kit (JDK) provided and supported by SAP. The SAP JVM is fully compliant to the Java Standard Edition 5. It is available on the Installation Master DVD and is installed automatically by SAPinst when you start the installation.</td>
</tr>
<tr>
<td>Visual Administrator tool integrated in SAP NetWeaver Administrator</td>
<td>SAP NetWeaver Administrator is a brand new solution for monitoring and administering Java systems and their applications. It is a web-based tool for administration, configuration, and monitoring. The Visual Administrator tool is no longer available as a separate tool. It has been integrated in the SAP NetWeaver Administrator. SAP NetWeaver Administrator offers you most of the functions previously available in Visual Administrator, but redesigned for the task-oriented approach of SAP NetWeaver Administrator. For more information about SAP NetWeaver Administrator, see the SAP NetWeaver Master Guide and the following: <a href="http://www.sdn.sap.com/irj/sdn/netweaver">http://www.sdn.sap.com/irj/sdn/netweaver</a></td>
</tr>
<tr>
<td>SAP Solution Manager Diagnostics Agent</td>
<td>A SAP Solution Manager Diagnostics Agent (Diagnostics Agent) is a standalone Java program that runs on each of the systems managed by SAP Solution Manager Diagnostics. It gathers information and reports to the SAP Solution Manager system. For more information about the Diagnostics Agent, see <a href="http://service.sap.com/diagnostics">http://service.sap.com/diagnostics</a>. The installation of the Diagnostics Agent is now part of the Installation Master DVD. That is, you can choose between the following options: If there is no Diagnostics Agent already installed on this physical or virtual host, it is installed automatically with an AS Java primary application server instance and additional application server instance. You can also install it as a standalone engine, for example if you want a non-SAP system to be managed by SAP Solution Manager Diagnostics. The installation of the Diagnostics Agent as a standalone engine is not described in this installation guide, but in the Diagnostics Agent Setup Guide, which is available at <a href="http://service.sap.com/diagnostics">http://service.sap.com/diagnostics</a>.</td>
</tr>
</tbody>
</table>
Operating Systems

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
</table>

Documentation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td>You can now access SAP Notes directly in SAP Service Marketplace from your PDF. Place the cursor on the SAP Note &lt;number&gt; and double-click. A separate browser window opens to display the SAP Note.</td>
</tr>
<tr>
<td>Links to the Internet</td>
<td>You can use the new links in the PDF files of the guides as follows:&lt;br&gt;■ Click the section headings such as New Features to jump back to the table of contents at the beginning of the guide.&lt;br&gt;■ Click an internet link such as <a href="http://service.sap.com">http://service.sap.com</a> to jump to the corresponding internet page.</td>
</tr>
</tbody>
</table>

1.3 SAP Notes for the Installation

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note, which you can find at [http://service.sap.com/notes](http://service.sap.com/notes).

SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>966416</td>
<td>SAP NetWeaver Installation Based on Kernel 7.10: UNIX</td>
<td>UNIX-specific information about the installation for SAP systems based on kernel 7.10 and corrections to this documentation.</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems</td>
</tr>
<tr>
<td>953763</td>
<td>Installation of SAP NetWeaver Composition Environment 7.1</td>
<td>CE-specific information about the installation and corrections to this documentation.</td>
</tr>
</tbody>
</table>
### 1.4 Online Information from SAP

More information is available online as follows.

#### Documentation

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Guide SAP Solution Manager 4.0</td>
<td><a href="http://service.sap.com/instguides">http://service.sap.com/instguides</a> ▶ SAP Components ▶ SAP Solution Manager Release 4.0 ▶</td>
<td>Master Guide — SAP Solution Manager 4.0</td>
</tr>
</tbody>
</table>
1.5 Accessing the SAP Library

For more information about SAP NetWeaver, access the SAP Library from the SAP Help Portal at http://help.sap.com.

The references to SAP NetWeaver Library documentation in this documentation always refer to the following entry point on the SAP Help Portal:
1.6 Naming Conventions

In this documentation, the following naming conventions apply:

**Terminology**
- *SAP system* refers to *SAP NetWeaver CE 7.1*.
- *Diagnostics Agent* refers to *SAP Solution Manager Diagnostics Agent*.

**Variables**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;SAPSID&gt;</td>
<td>SAP system ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;sapid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;sid&gt; and &lt;sapid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;DBSID&gt;</td>
<td>Database ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;dbsid&gt;</td>
<td>Database ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;host_name&gt;</td>
<td>Name of the corresponding host</td>
</tr>
<tr>
<td>&lt;user_home&gt;</td>
<td>Home directory of the user performing the installation.</td>
</tr>
<tr>
<td>&lt;INSTDIR&gt;</td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td>&lt;DVD_DIR&gt;</td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td>&lt;OS&gt;</td>
<td>Operating system name within a path</td>
</tr>
<tr>
<td>&lt;SCHEMAID&gt;</td>
<td>Database schema ID</td>
</tr>
</tbody>
</table>

The following example shows how the variables are used:

**Example**

Log on as user `<sapid>adm` and change to the directory `/usr/sap/<SAPSID>`.

If your SAP system ID is C11, log on as user `c11adm` and change to the directory `/usr/sap/C11`. 
This page is intentionally left blank.
2 Planning

This section provides general planning information.

You must first:

1. Plan your SAP system landscape according to the Master Guide and the Technical Infrastructure Guide available for your product.
2. Decide on your installation option [page 15].

Now continue with the section for your chosen installation option below.

Standard, Distributed, or High-Availability System

1. You plan your system configuration [page 25].
2. You decide on the transport host to use [page 26].
3. If you want to use Adobe Document Services (ADS), you check what you have to do if your platform is not supported for ADS [page 27].
4. You decide whether you want to install multiple components in one database (MCOD) [page 31].
5. If you want to install a high-availability system, you read Planning the Switchover Cluster [page 33].

End of: HA (UNIX)

6. You can now continue with Preparation [page 37].

Additional Application Server Instance

You do not have to perform any planning steps.
You can immediately continue with Preparation [page 37].

Host Agent as a Standalone Installation

You do not have to perform any planning steps.
You can immediately continue with Preparation [page 37].

2.1 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide.

- Standard system [page 16] (formerly known as central system)
- Distributed system [page 16]
2 Planning

2.1 Installation Options Covered by this Guide

- High-availability system [page 17]

Only valid for: HA (UNIX)

End of: HA (UNIX)

- You can install one or more additional application server instance(s) [page 18] to an existing standard, distributed or high-availability system.
- You can install a standalone host agent [page 21].

### 2.1.1 Standard System

You can install a **standard** system on a **single** host.

In a standard system, all main instances run on a single host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

**Figure 1:** Standard Java System

![Diagram of Standard Java System]

Optionally you can install one or more additional application server instances. For more information, see *Additional Application Server Instance* [page 18].

### 2.1.2 Distributed System

In a **distributed** system, every instance can run on a separate host:
Central services instance (SCS)
Database instance (DB)
Primary application server instance

Note
You can also use the SAP transport host or the SAP global host as your primary application server instance host.

Optionally you can install one or more additional application server instances. For more information, see Installation of an Additional Application Server Instance [page 18].

Figure 2: Distributed Java System

2.1.3 High-Availability System

In a high-availability system, every instance can run on a separate host:

- Java Central Services Instance (SCS)
- Database instance
- Primary application server instance
We recommend that you run the SCS in a switchover cluster infrastructure. The SCS must have its own Enqueue Replication Server (ERS) instance. Optionally you can install one to <n> additional application server instances. For more information, see Installation of an Additional Application Server Instance [page 18].

The following figures show examples for the distribution of the SAP instances in a high-availability system.

**Figure 3:** High-Availability System

---

**2.1.4 Additional Application Server Instance**

You can install one or more additional application server instance(s) for an existing SAP system. An additional application server instance can run on:

- The host of any instance of the existing SAP system (exceptions see below)
2 Planning
2.1 Installation Options Covered by this Guide

- On a dedicated host

**Note**
If you want to install additional application server instances running on another operating system than the primary application server instance, for example if your primary application server instance runs on Solaris, but the additional application server instances shall run on Windows, see *Heterogeneous SAP System Installation* [page 129].

**Additional Application Server Instance for a Standard System**
For example, the following figure shows each of the three additional application server instances that are running:

- On the main host of the SAP system, that is on the host on which the primary application server instance and the database instance run
- On dedicated hosts

**Figure 4:** Additional Application Server Instance for a Standard System

For additional information, see *Standard System* [page 16].

**Additional Application Server Instance for a Distributed System**
For example, the following figure shows each of the three additional application server instances that are running:
2 Planning
2.1 Installation Options Covered by this Guide

- On the main host of the SAP system, that is on the host on which the primary application server instance and the database instance run
- On dedicated hosts

It is not recommended to install additional application server instance(s) on the SAP global host.

**Figure 5:** Additional Application Server Instance for a Distributed System

For additional information, see *Distributed System* [page 16].

*Only valid for: HA (UNIX)*

**Additional Application Server Instance for a High-Availability System**

For example, the following figure shows each of the three additional application server instances that are running on:

- The host of the primary application server instance
- Dedicated hosts

It is not recommended to install additional application server instance(s) on the switchover cluster infrastructure.
Figure 6: Additional Application Server Instance for a High-Availability System

For more information, see High-Availability System [page 17].

2.1.5 Standalone Host Agent

Using the host agent you can centrally monitor any host with the Alert Monitor or the SAP NetWeaver Administrator or the Adaptive Computing Controller (ACC). In addition, the host agent is used by the ACC for starting, stopping, and relocating SAP instances and databases. For more information on the ACC see http://sdn.sap.com/irj/sdn/adaptive.

The host agent is automatically installed during the installation of all SAP NetWeaver instances and components.

You only need to install a standalone host agent in the following cases:

- You want to manage a host that does not have an SAP instance or component.
- You have upgraded your SAP system to SAP NetWeaver 7.1 or higher and want to the instances of the upgraded system to be managed by the ACC.
The host agents contain the following elements:

- The control program saphostexec
- The SAP NetWeaver Management agent SAPHostControl (sapstartsrv in host mode)
- The sapacosprep executable of the Adaptive Computing Infrastructure
- The operating system collector saposcol

**Note**

The installed programs are automatically started when the host is booted. The automatic start is ensured by the startup script sapinit that starts the required executables.

**More Information**

For more information about the host agent, see the SAP Library [page 12]:

> Function-Oriented View > Application Server ABAP > Administration Tools for AS ABAP > Monitoring in the CCMS > Infrastructure of the NetWeaver Management Agents

### 2.2 Distribution of Components to Disks

When you install the SAP system, the installation tools prompt you to enter drive letters for the main components of the system. This lets you distribute components to disks in the system as required. How you do this significantly affects system throughput and data security, so you need to plan it carefully.
The best distribution depends on your environment and must reflect factors such as the size of the components involved, security requirements, and the expected workload. When you work out the assignment of components to disks, you first need to get an overview of the main components and their corresponding directories. On the basis of sample configurations and the recommendations provided in this documentation, you can then choose the best setup for your particular system.

In most situations, SAP systems are installed on RAID arrays to guarantee data redundancy. Therefore, this documentation focuses on RAID subsystems and drives.

**Features**

The following graphic shows how you can distribute the main directories created during the installation to Redundant Arrays of Independent Disks (RAID). The distribution is suitable for an average-sized production system. Keep in mind that this is only an example and that no single solution fits all environments.

![Diagram showing directory distribution for RAID](image)

**Figure 8:** Directory Distribution for RAID

This configuration is suitable for the main host of a central system or the database server of a standalone database system. You can assign the components on the left to any of the arrays shown. You do not necessarily have to place the transport directory on the central instance host.
This setup has the following key features:

- **Security of the Logs**
  The security of the logs is crucial. The logs record all the changes made to the database and so provide the information that is necessary to recover a damaged database. Therefore, it is important that they are stored securely and that you never lose them at the same time as the database data. By placing the redo logs on a different array to the database data, you can make sure that they are not lost if the array with the database data is severely damaged.

- **Performance**
  You can reduce I/O bottlenecks by placing the original logical log on a different array than the mirrored log. Original and mirrored logs are written in parallel. If they are located on the same array, this results in a high level of write activity that has to be handled by the same controller. By separating original and mirrored logs, you can distribute the write activity to two different arrays, so reducing I/O bottlenecks.

- **RAID**
  By using RAID 1 arrays for the original and mirrored logs, you get high data security and good performance. The data is written to a primary disk and duplicated identically to a second disk. If one disk fails, the data is still intact on the second disk.
  The use of RAID 5 for the database ensures fault tolerance. The data is striped over all the disks in the array together with parity information. If one disk fails, the parity information is used to automatically reconstruct the data lost on the damaged disk.

- **Number of RAID Arrays**
  In the example above, three RAID 1 arrays are used for the redo logs to ensure optimal performance and security. If you do not need the disk capacity offered by three arrays and can accept reduced performance, consider using a single array. In this case, you can use a single RAID 1 array for the original and mirrored logs.
2.3 SAP MaxDB System Configuration

Security Issues

- For security reasons the logs must be mirrored using the operating system or hardware.

  Caution
  If a system runs without mirroring, you might lose all data since the last complete backup in the event of a disk crash.

  Recommendation
  We recommend mirroring the logs using the operating system or hardware.
  If this is not possible, then mirror the logs with the database mirroring provided by SAP MaxDB.

- We recommend you to run the database with raw devices.

  Caution
  Never use RAID 5 systems for database log volumes.

- Do not replace file systems by softlinks.
- Raw devices are secure in the event of a system crash.

Security Concept for Database Software Owner

As of SAP MaxDB 7.5.00 there is a new security concept for the database software owner. Authorization to access directories and files is restricted, and a new user and user group is required:

- User is sdb (SAP MaxDB default)
- User group is sdba (SAP MaxDB default)

This user and group are the only database software owners on the host. For security reasons, the user does not have a logon for the system, which guarantees the physical integrity of the database files. Database processes run under this user, which makes sure that several different users cannot manipulate the database system.

Performance Issues

- Store database data files and logs on different disks
- Since the logs are written synchronously, they produce the most I/O activity of all database files.
- It is possible to put the logs on the same disk as sapmnt, but this is not recommended.
- Use the partitions DISK<0..N> exclusively for data files of the database.
- If paging or swapping areas and log data reside on the same disk, the performance is poor.
- For database volumes, raw devices are faster than files. The slowest disk drive determines the I/O performance of the database.
Different SAP MaxDB Systems
For performance reasons, we recommend that you do not install several database systems (for different SAP systems) on one single host. If you still decide to do so, you must install each database as described in this documentation.

Recommended Configuration
The following graphic shows an optimal distribution of the database data on different disks.

Optimal Distribution

For more information about the file systems for the SAP system and the SAPMaxDB database, see Setting Up File Systems and Raw Devices [page 66].

2.4 SAP System Transport Host

The transport host contains the transport directory that is used by the SAP transport system to store transport data and change information of SAP systems, such as software programs, data dictionary data, or customization data. If you have several SAP systems, they are usually organized in transport domains. In most cases, all SAP systems in a transport domain have a common transport directory. For more information, see the SAP Library [page 12]:
2.5 Running Adobe Document Services on Nonsupported Platforms

Adobe document services (ADS) are currently not supported to run natively on all platforms supported by SAP systems based on SAP NetWeaver, in particular on 64-bit platforms.

Procedure
To use ADS in SAP landscapes on nonsupported platforms, install an additional standalone AS Java on a platform supported by ADS.
For more information, see SAP Note 925741.

More Information
For more information about running ADS on SAP systems based on SAP NetWeaver, see http://sdn.sap.com/irj/sdn/adobe.

2.6 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol (LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the directory.
LDAP defines a standard protocol for accessing directory services, which is supported by various directory products such as Microsoft Active Directory, and OpenLDAP slapd. Using directory services enables important information in a corporate network to be stored centrally on a server. The advantage of storing information centrally for the entire network is that you only have to maintain data once, which avoids redundancy and inconsistency.
If an LDAP directory is available in your corporate network, you can configure the SAP system to use this feature. For example, a correctly configured SAP system can read information from the directory and also store information there.

**Note**

The SAP system can interact with the Active Directory using the LDAP protocol, which defines:

- The communication protocol between the SAP system and the directory
- How data in the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows server, you can configure the SAP system to use the information available there. In the following text, directories other than the Active Directory that implement the LDAP protocol are called **generic LDAP directories**.

**Caution**

This section does not provide information about the use of LDAP directories with the LDAP Connector. For more information about using and configuring the LDAP Connector for an ABAP system, see the SAP Library [page 12]:


**Prerequisites**

You can only configure the SAP system for Active Directory services or other LDAP directories if these are **already available** on the network. As of Windows 2000 or higher, the Active Directory is automatically available on all domain controllers. A generic LDAP directory is an additional component that you must install separately on a UNIX or Windows server.

**Features**

In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory by using:

- SAP Logon
- The SAP Microsoft Management Console (SAP MMC)
- The SAP Management Console (SAP MC)

For more information about the automatic registration of SAP components in LDAP directories and the benefits of using it in SAP Logon and SAP MMC, see the documentation *SAP System Information in Directory Services* on SAP Service Marketplace at:


For more information about the SAP MC and about how to configure it to access LDAP Directories, see the documentation *SAP Management Console* in the SAP Library [page 12]:

---

28/146  PUBLIC  05/16/2008
2.6 Integration of LDAP Directory Services

**SAP Logon**

Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the `sapmsg.ini` configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon to use the LDAP directory, it queries the directory each time `Server` or `Group` selection is chosen to fetch up-to-date information on available SAP systems.

To use LDAP operation mode, make sure that the `sapmsg.ini` file contains the following:

```
[Address]
Mode=LDAPdirectory
LDAPserver=
LDAPnode=
LDAPoptions=
```

Distinguish the following cases:

- If you use an Active Directory, you must set `LDAPoptions="DirType=NT5ADS"`. For more information, see the SAP system profile parameter `ldap/options`.
- You must specify the directory servers (for example, `LDAPserver=pcintel6 p24709`) if either of the following is true:
  - The client is not located in the same domain forest as the Active Directory
  - The operating system does not have a directory service client (Windows NT and Windows 9X without installed `disclient`).

  For more information, see the SAP system profile parameter `ldap/servers`.
- For other directory services, you can use `LDAPnode` to specify the distinguished name of the SAP root node. For more information, see the SAP system profile parameter `ldap/saproot`.

**SAP MMC**

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together with Active Directory services. You can keep track of significant events in all of the systems from a single SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such changes are automatically updated in the directory and subsequently reflected in the SAP MMC.
If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the instances running on Unix.

**SAP MC**

The SAP MC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. The SAP MC is automatically set up when you install an SAP system on any platform. If the SAP system has been prepared correctly, the SAP MC presents and analyzes system information that it gathers from various sources, including a generic LDAP Directory. Integrating a generic LDAP Directory as a source of information has advantages for the SAP MC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MC.

**Configuration Tasks for LDAP Directories**

This section describes the configuration tasks you have to perform for the Active Directory or other (generic) LDAP directories.

**Configuration Tasks for Active Directory**

To enable an SAP system to use the features offered by the Active Directory, you must configure the Active Directory so that it can store SAP system data.

To prepare the directory, you use SAPinst to automatically:

- Extend the Active Directory schema to include the SAP-specific data types
- Create the domain accounts required to enable the SAP system to access and modify the Active Directory. These are the group `SAP_LDAP` and the user `sa1ldap`.
- Create the root container where information related to SAP is stored
- Control access to the container for SAP data by giving members of the `SAP_LDAP` group permission to read and write to the directory

You do this by running SAPinst on the Windows server on which you want to use Active Directory Services and choosing `<SAP System>` > `Software Life-Cycle Options` > `LDAP Registration` > `Active Directory Configuration`. For more information about running SAPinst on Windows, see documentation `Installation Guide — <your product> on Windows: <Database>.

**Note**

You have to perform the directory server configuration only once. Then all SAP systems that need to register in this directory server can use this setup.

**Configuration Tasks for Generic LDAP Directories**

To configure other LDAP directories, refer to the documentation of your directory vendor.
Enabling the SAP System LDAP Registration

Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP system by setting some profile parameters in the default profile. To do this, run SAPinst [page 89] once for your system and choose:

- <SAP System> > Software Life-Cycle Options > LDAP Registration > LDAP Support

If you use a directory server other than Microsoft Active Directory and/or non-Windows application servers, you have to store the directory user and password information by using ldappasswd pf=<any_instance_profile>. The information is encrypted for storage in DIR_GLOBAL and is therefore valid for all application servers. After restarting all application servers and start services, the system is registered in your directory server. The registration protocols of the components are dev_ldap*. The registration is updated every time a component starts.

2.7 Installation of Multiple Components in One Database

You can install multiple SAP systems in a single database. This is called Multiple Components in One Database (MCOD).

MCOD is available with all SAP components. This technology is available on all the major databases for the SAP system, in line with our commitment to deliver platform-independent solutions. Using this technology is as easy as installing a separate component. No extra effort is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is not an additional installation option. Instead, it is an option of the database instance installation.

There are two MCOD scenarios:

- The installation of an SAP system in a new database
- The installation of an additional SAP system in an existing database

Prerequisites

- For about MCOD and its availability on different platforms, see [http://service.sap.com/mcod](http://service.sap.com/mcod).
- Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP instances only.
- Improved sizing required

In general, you calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP system. You can do the same for memory resources and disk space.

You can size multiple components in one database by sizing each individual component using the SAP Quick Sizer and then adding the requirements together. For about the SAP Quick Sizer, see [http://service.sap.com/sizing](http://service.sap.com/sizing).
2  Planning
2.8  Planning the Switchover Cluster

Features

- Reduced administration effort
- Consistent system landscape for backup, system copy, administration, and recovery
- Increased security and reduced database failure for multiple SAP systems due to monitoring and administration of only one database
- Independent upgrade
  In an MCOD landscape, you can upgrade a single component independently from the other components running in the same database, assuming that the upgraded component runs on the same database version. However, if you need to restore a backup, be aware that all other components are also affected.

Note

Special MCOD considerations and differences from the standard procedure are listed where relevant in the installation documentation.

Constraints

- We strongly recommend that you test MCOD in a test or development system. We recommend that you run MCOD systems in the same context. We do not recommend that you mix test, development, and production systems in the same MCOD.
- In the event of database failure, all SAP systems running on the single database are affected.
- Automated support in an MCOD landscape for the following administrative tasks depends on your operating system and database:
  - Copying a single component from an MCOD landscape to another database at database level.
  - De-installing a single component from an MCOD landscape requires some additional steps.
    You can use a remote connection to SAP support to request help with these tasks. For more information, see http://service.sap.com/remoteconnection.
- When you use stopsap in an MCOD system with two primary application server instances, only one primary application server instance is stopped. Therefore, you must first stop the other SAP system with stopsap R3 to make sure that the database is also stopped.
- You cannot install a Unicode SAP system with a non-Unicode SAP system in one database.
- For the first SAP system, the database system ID can be different from the SAP system ID.
- For the second SAP system, you must use the same DBSID as for the first SAP system.
- If you decide to turn off database logging during the database load phase of the installation, you need to plan downtime for all MCOD systems sharing the database.
2.8 Planning the Switchover Cluster

You can reduce unplanned downtime for your SAP system by setting up a switchover cluster. This setup installs critical software units – known as “single points of failure” (SPOFs) – across multiple host machines in the cluster. In the event of a failure on the primary node, proprietary switchover software automatically switches the failed software unit to another hardware node in the cluster. Manual intervention is not required. Applications accessing the failed software unit might experience a short delay but can then resume processing as normal.

Switchover clusters also have the advantage that you can deliberately initiate switchover to free up a particular node for planned system maintenance. Switchover solutions can protect against hardware failure and operating system failure but not against human error, such as operator errors or faulty application software. Additional downtime might be caused by upgrading your SAP system or applying patches to it.

Without a switchover cluster, the SAP system SPOFs — central services instance, the database instance, and the central file share — are vulnerable to failure because they cannot be replicated. All of these can only exist once in a normal SAP system.

You can protect software units that are not SPOFs against failure by making them redundant, which means simply installing multiple instances. For example, you can add additional application server instances. This complements the switchover solution and is an essential part of building HA into your SAP system.

Recommendation

We recommend switchover clusters to improve the availability of your SAP system.

A switchover cluster consists of:

- A hardware cluster of two or more physically separate host machines to run multiple copies of the critical software units, in an SAP system the SPOFs referred to above
- Switchover software to detect failure in a node and switch the affected software unit to the standby node, where it can continue operating
- A mechanism to enable application software to seamlessly continue working with the switched software unit — normally this is achieved by virtual addressing (although identity switchover is also possible)

Prerequisites

You must first discuss switchover clusters with your hardware partner because this is a complex technical area. In particular, you need to choose a proprietary switchover product that works with your operating system.
We recommend that you read the following documentation before you start:

- Check the informations and the installation guides that are available at [http://sdn.sap.com/irj/sdn/ha](http://sdn.sap.com/irj/sdn/ha).
- The enqueue replication server (ERS) is a major contribution to an HA setup and is essential for a Java system. You need one ERS for each Java SCS installed in your system.

**Features**

The following graphic shows the essential features of a switchover setup:

**Figure 10: Switchover Setup**

This graphic and the graphics in this section are only examples. You need to discuss your individual HA setup with your HA partner.

These graphics summarize the overall setup and do not show the exact constellation for an installation based on one of the available technologies.

The following graphic shows an example of a switchover cluster in more detail:
Figure 11: Switchover Cluster

Constraints
This documentation concentrates on the switchover solution for the central services instance. For more information about how to protect the Network File System (NFS) software and the database instance by using switchover software or (for of the database) replicated database servers, contact your HA partner.

You need to make sure that your hardware is powerful enough and your configuration is robust enough to handle the increased workload after a switchover. Some reduction in performance might be acceptable after an emergency. However, it is not acceptable if the system comes to a standstill because it is overloaded after switchover.

End of: HA (UNIX)
This page is intentionally left blank.
3 Preparation

This section includes the preparation steps that you have to perform for the:

- Standard, distributed or high-availability system
- Additional application server instance
- Standalone host agent

Preparation Steps for a Standard, Distributed, or High-Availability System

Note
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. You identify basic SAP system parameters [page 38].
2. You check the hardware and software requirements [page 45] for every installation host of the HA system landscape that you want to install.
3. You make sure that the required operating system users and groups [page 61] are created.
4. If you want to configure the User Management Engine (UME) of Application Server Java (AS Java) for the user management of a separate ABAP system, you have to prepare user management for an external ABAP System [page 63].
5. You set up file systems and raw devices [page 66] and make sure that the required disk space is available for the directories to be created during the installation.
6. If you want to share the transport directory trans from another system, export [page 77] this directory to your installation hosts.
7. If you want to use virtual host names, you have to set the environment variable SAPINST_USE_HOSTNAME [page 89]. Alternatively you can specify the virtual host name in the command to start SAPinst.

| Only valid for: HA (UNIX) |

8. If you want to install a high-availability system, you perform switchover preparations [page 60].

| End of: HA (UNIX) |

9. You generate the SAP Solution Manager Key [page 80].
10. You make sure that the required installation media [page 80] are available on every host on which you want to install an instance of your SAP system.
11. You can continue with Installation [page 85].
Preparation Steps for an Additional Application Server Instance

You have to perform the following preparations on the host where you install the additional application server instance(s):

1. You identify basic SAP system parameters [page 38].
2. You check the hardware and software requirements [page 45] for every installation host on which you want to install one or more additional application server instances.
3. You make sure that the required operating system users and groups [page 61] are created.
4. You set up file systems and raw devices [page 66] and make sure that the required disk space is available for the directories to be created during the installation.
5. If you want to share the transport directory trans from another system, export [page 77] this directory to your installation hosts.
6. If you want to use a virtual host name, you have to set the environment variable SAPINST_USE_HOSTNAME [page 89]. Alternatively you can specify the virtual host name in the command to start SAPinst.
7. You make sure that the required installation media [page 80] are available on every host on which you want to install one or more additional application server instances.
8. You can continue with Installation [page 85].

Preparation Steps for a Standalone Host Agent

You have to perform the following preparations on the host where you install a standalone host agent:

1. You identify basic SAP system parameters [page 38].
   You can find the parameters in the table Host Agent.
2. You check the hardware and software requirements [page 45] on the installation host.
   You can find the requirements for the Host Agent in section Requirements for a Standalone Host Agent.
3. You make sure that the required operating system users and groups [page 61] are created.
   You can find the operating system user for the Host Agent in the tables User and Groups of the Standalone Host Agent and Groups and Members of the Standalone Host Agent User.
4. You set up file systems and raw devices [page 66] and make sure that the required disk space is available for the directories to be created during the installation.
   You can find the directories for the Host Agent in section Host Agent Directories.
5. You make sure that the required installation media [page 80] are available on the installation host.
   You can find the installation media that are required for the installation of a standalone host agent in the row Host Agent (Standalone) of the media table.
6. You can continue with Installation [page 85].

3.1 Basic SAP System Parameters

SAPinst asks whether you want to run the installation in Typical or Custom mode.
If you choose *Typical*, SAPinst provides automatic default settings and you only have to respond to a minimum number of prompts. However, you can still change any of the default settings on the parameter summary screen.

The tables below list the basic system parameters that you always need to specify before installing your SAP system, both in typical and in custom mode.

For all other SAP system parameters, use the [F1] help in the SAPinst dialogs.

### SAP System ID and Database ID

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP system ID &lt;SAPSID&gt; identifies the entire SAP system. SAPinst prompts you for the &lt;SAPSID&gt; when you execute the first installation option to install a new SAP system. If there are further installation options to be executed, SAPinst prompts you for the profile directory. For more information, see the description of the parameter SAP System Profile Directory.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>This prompt appears when you install the central services instance, which is the first instance to be installed in a distributed system.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>Choose your SAP system ID carefully. Renaming is difficult and requires you to reinstall the SAP system.</td>
</tr>
<tr>
<td></td>
<td>Make sure that your SAP system ID:</td>
</tr>
<tr>
<td></td>
<td>- Is unique throughout your organization</td>
</tr>
<tr>
<td></td>
<td>- Consists of exactly three alphanumeric characters</td>
</tr>
<tr>
<td></td>
<td>- Contains only uppercase letters</td>
</tr>
<tr>
<td></td>
<td>- Has a letter for the first character</td>
</tr>
<tr>
<td></td>
<td>- Does not include any of the following, which are reserved IDs:</td>
</tr>
<tr>
<td></td>
<td>ADD ALL AND ANY ASC AUX COM CON DBA END EPS FOR GID IBM INT KEY LOG LPT MON NIX NOT NUL OFF OMS PRN RAW ROW SAP SET SGA SHG SID SQL SYS TMP UID USR VAR</td>
</tr>
<tr>
<td>Database ID &lt;OBSID&gt;</td>
<td>The &lt;OBSID&gt; identifies the database instance. SAPinst prompts you for the &lt;OBSID&gt; when you are installing the database instance. The &lt;OBSID&gt; can be the same as the &lt;SAPSID&gt;.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>Choose your database ID carefully. Renaming is difficult and requires you to reinstall the SAP system.</td>
</tr>
<tr>
<td></td>
<td><strong>If you want to install a new database:</strong></td>
</tr>
<tr>
<td></td>
<td>Make sure that your database ID:</td>
</tr>
<tr>
<td></td>
<td>- Is unique throughout your organization</td>
</tr>
<tr>
<td></td>
<td>- Consists of exactly three alphanumeric characters</td>
</tr>
<tr>
<td></td>
<td>- Contains only uppercase letters</td>
</tr>
</tbody>
</table>
3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID <code>&lt;SMDSID&gt;</code> of SAP Solution Manager Diagnostics Agent</td>
<td>SAPInst sets <code>&lt;SMDSID&gt;</code> to DAA by default. If DAA is already used by another SAP system that is not a Diagnostics Agent instance, <code>&lt;SMDSID&gt;</code> is set to DA&lt;xx&gt;, where &lt;xx&gt; can be any letter from A to Z, and DA stands for “DiagnosticsAgent”). If required, you can change <code>&lt;SMDSID&gt;</code> to a value of your choice on the Parameter Summary screen. If you do so, the same naming conventions as for <code>&lt;SAPSID&gt;</code> apply. For more information, see entry “SAP System ID <code>&lt;SAPSID&gt;</code>” in this table above.</td>
</tr>
</tbody>
</table>

SAP System Profile Directory

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/&lt;sapmnt&gt;/&lt;SAPSID&gt;/profile</code> or <code>/usr/sap/&lt;SAPSID&gt;/SYS/profile</code></td>
<td>The installation retrieves the parameters entered earlier from the SAP system profile directory. SAPInst prompts you to enter the location of the <code>profile</code> directory when the installation option that you execute is not the first one belonging to your SAP system installation. See also the description of the parameters <code>SAP System ID</code> and <code>Database ID</code>. <code>/usr/sap/&lt;SAPSID&gt;/SYS/profile</code> is the soft link referring to <code>/&lt;sapmnt&gt;/&lt;SAPSID&gt;/profile</code>.</td>
</tr>
</tbody>
</table>

Note

If you install an additional application server instance in an existing SAP system, SAPInst also prompts you for the profile directory of the existing SAP system.

SAP System Instances, Hosts, and Ports

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Instance Number of the SAP system | Instance Number:

Technical identifier that is required for every instance of an SAP system, consisting of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. The instance number is used to specify the names of the SAP system instance directories which are created automatically by SAPInst during the installation: |
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- The directory both of the primary application server instance and of an additional application server instance is called J&lt;Instance_Number&gt;.</td>
</tr>
<tr>
<td></td>
<td>- The directory of the central services instance is called SCS&lt;Instance_Number&gt;.</td>
</tr>
<tr>
<td></td>
<td>- The directory of the Enqueue Replication Server instance is called ERS&lt;Instance_Number&gt;.</td>
</tr>
<tr>
<td></td>
<td>Only valid for: HA (UNIX)</td>
</tr>
<tr>
<td></td>
<td>For more information, see SAP Directories [page 67].</td>
</tr>
<tr>
<td>Instance Number for the</td>
<td>Technical identifier for internal processes for the Diagnostics Agent, consisting of a two-digit number from 00 to 98.</td>
</tr>
<tr>
<td>Diagnostics Agent</td>
<td>The instance number is set automatically to the next free and valid instance number that has not yet been assigned to the SAP system.</td>
</tr>
<tr>
<td></td>
<td>The instance number is used to specify the name of the Diagnostics Agent instance directory which are created automatically by SAPInst during the installation:</td>
</tr>
<tr>
<td></td>
<td>The directory of the Diagnostics Agent instance is called J&lt;Instance_Number&gt;.</td>
</tr>
<tr>
<td></td>
<td>For more information, see SAP Directories [page 67].</td>
</tr>
<tr>
<td></td>
<td>The same restrictions apply as in “Instance Number of the SAP system” (see above).</td>
</tr>
<tr>
<td>Virtual Host Name</td>
<td>You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to order to conceal their physical network identities from each other.</td>
</tr>
<tr>
<td></td>
<td>This may be useful when moving SAP servers or complete server landscapes to other new hardware within a short time frame without having to carry out a reinstall or complicated reconfiguration.</td>
</tr>
<tr>
<td></td>
<td>If you want to use virtual host names for the installation, you have to specify the virtual host name [page 89] before you start SAPInst.</td>
</tr>
<tr>
<td></td>
<td>Only valid for: HA (UNIX)</td>
</tr>
<tr>
<td></td>
<td>If you want to install a high-availability (HA) system [page 17], you need the virtual host name when you install the SCS instance into a cluster.</td>
</tr>
<tr>
<td></td>
<td>End of: HA (UNIX)</td>
</tr>
<tr>
<td></td>
<td>For more information about the use of virtual TCP/IP host names, see SAP Note 962955.</td>
</tr>
<tr>
<td></td>
<td>The host name must not exceed 12 characters. For more information about the allowed host name length and characters, see SAP Note 611361.</td>
</tr>
<tr>
<td>Message Server Port</td>
<td><img src="image" alt="Caution" /></td>
</tr>
<tr>
<td></td>
<td>The message server port number must be unique for the SAP system on all hosts. If there are several message port numbers on one host, all must be unique.</td>
</tr>
<tr>
<td></td>
<td><strong>Port Number of the SAP Message Server:</strong></td>
</tr>
<tr>
<td></td>
<td>If you do not specify a value, the default port number is used.</td>
</tr>
<tr>
<td></td>
<td>The SCS instance profile contains the configuration for the Java message server.</td>
</tr>
<tr>
<td></td>
<td>The Java message server port uses the parameter rdistp/msserv_internal with default value 39&lt;nn&gt;, where &lt;nn&gt; is the instance number of the SCS message server instance.</td>
</tr>
<tr>
<td></td>
<td>For more information about the parameters used for message server ports, see SAP Note 821875.</td>
</tr>
</tbody>
</table>
Master Password

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Password</td>
<td>This password is used for all new user accounts SAPinst creates and for the secure store key phrase. The length has to be 8 to 14 characters. Depending on your installation scenario there might be more restrictions.</td>
</tr>
</tbody>
</table>

⚠️ Caution

If you do not create the operating system users manually, SAPinst creates them with the common master password. For more information, see the description of the parameter Operating System Users. In this case, make sure that the master password meets the requirements of your operating system and of your database.

Operating System Users of the SAP System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User &lt;sapsid&gt;adm</td>
<td>User &lt;sapsid&gt;adm is the system administrator user. If you did not create user &lt;sapsid&gt;adm manually before the installation, SAPinst creates it automatically during the installation. SAPinst sets the Master Password by default, but you can overwrite it either by choosing parameter mode Custom or by changing it on the parameter summary screen. Make sure that the user ID and group ID of this operating system user are unique and the same on each application server instance host. For more information, see Creating Operating System Users [page 61].</td>
</tr>
<tr>
<td>User sapadm</td>
<td>User sapadm is used for central monitoring services. If you did not create user sapadm manually before the installation, SAPinst creates it automatically during the installation. SAPinst sets the Master Password by default, but you can overwrite it either by choosing parameter mode Custom or by changing it on the parameter summary screen. Make sure that the user ID and group ID of sapadm are unique and the same on each application server instance host. For more information, see Creating Operating System Users [page 61].</td>
</tr>
<tr>
<td>User &lt;smdsid&gt;adm</td>
<td>User &lt;smdsid&gt;adm is dedicated to the Diagnostics Agent installation with sufficient authorization to manage the agent. If you did not create user &lt;smdsid&gt;adm manually before the installation, SAPinst creates it automatically during the installation. It is created on the central instance host and on every dialog instance host. SAPinst sets the Master Password by default, but you can overwrite it either by choosing parameter mode Custom or by changing it on the parameter summary screen. Make sure that the user ID and group ID of &lt;smdsid&gt;adm are unique and the same on each application server instance host. For more information, see Creating Operating System Users [page 61].</td>
</tr>
</tbody>
</table>
## User Management Engine (UME)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| UME Configuration      | SAPinst prompts you for how to configure the UME during the input phase of the installation. You can choose between the following options:  
  - Use Java database (default).  
    If you choose this option, administrators can manage users and groups with the UME Web admin tool and SAP NetWeaver Administrator only.  
  - Use an external ABAP system.  
    If you choose this option, administrators can manage users with the transaction SU01 on the external ABAP system, and, depending on the permissions of the communication user, also with the UME Web admin tool and SAP NetWeaver Administrator.  
    You must have created the required users manually on the external ABAP system.  
    For more information, see *Preparing User Management for an External ABAP System* [page 63].  
    For more information about supported UME data sources and change options, see SAP Note 718383.  
| **Using the Java Database:** |                                                                                                                                                                                                                                                                                                                                          |
| Java Administrator User | SAPinst sets the user name Administrator and the master password by default. If required, you can choose another user name and password according to your requirements.                                                                                                                                                                |
| Java Guest User        | SAPinst sets the user name Guest and the master password by default. The Guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group Authenticated Users and have read access only.                                                                                                                                 |
| **Using an External ABAP System – Parameters for the ABAP Connection:** |                                                                                                                                                                                                                                                                                                                                          |
| Application Server Instance Number | This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java.  
  To find out the number on the host of the primary application server instance, look under the SAP directory `usr/sap/<SAPSID>/DVEBMGS<nn>`. The value <nn> is the number assigned to the SAP system.                                                                                                    |
| Application Server Host | This is the host name of the relevant application server instance.  
  To find out the host name, enter `hostname` at the command prompt of the host running the primary application server instance.                                                                                                                                                                                                 |
| Communication User     | This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.                                                                                                                                                                                                 |
| **Using an External ABAP System – Parameters for the Application Server Java Connection:** |                                                                                                                                                                                                                                                                                                                                          |
| Administrator User     | This is the name and password of the administrator user that you created on the external ABAP system.                                                                                                                                                                                                                                                                 |
| Administrator Role     | The role `SAP_J2EE_ADMIN` must exist on the external ABAP system.                                                                                                                                                                                                                                                                                                                                 |


<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest User</td>
<td>This is the name and password of the guest user that you created on the external ABAP system. The guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <strong>Authenticated Users</strong> and have read access only.</td>
</tr>
<tr>
<td>Guest Role</td>
<td>The role <strong>SAP_J2EE_GUEST</strong> must exist on the external ABAP system.</td>
</tr>
</tbody>
</table>

**Key Phrase for Secure Store Settings**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Phrase for Secure Store Settings</td>
<td>This is a random word or phrase that is used to encrypt the secure store. The Java EE engine uses this phrase to generate the key that is used to encrypt the data. The uniqueness of the phrase you use contributes to the uniqueness of the resulting key.</td>
</tr>
</tbody>
</table>

**Recommendation**

Use a long key phrase that cannot be guessed easily. Use both uppercase and lowercase letters in the phrase and include special characters.

**Internet Communication Manager (ICM) User Management**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <strong>webadm</strong></td>
<td>The administration user <strong>webadm</strong> is created to use the web administration interface for Internet Communication Manager (ICM) and Web Dispatcher. SAPinst sets the master password by default. If required, you can choose another password. The length of the password must be between 5 and 128 characters.</td>
</tr>
</tbody>
</table>

**Host Agent**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of <strong>sapadm</strong></td>
<td>The administration user <strong>sapadm</strong> is created to use central monitoring services. If this user does not already exist, SAPinst automatically creates it. SAPinst prompts you to enter either the password of the existing user or a new password for the user to be created.</td>
</tr>
</tbody>
</table>

**Solution Manager Key**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Solution Manager key</td>
<td>To install your SAP system, you need to generate an SAP Solution Manager key [page 80], which the installation requires to continue. For more information, see SAP Note 805390.</td>
</tr>
</tbody>
</table>
Parameters Relevant for the Directory Structure of the System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP system mount directory</td>
<td>The SAP system mount directory <code>/&lt;sapmnt&gt;</code> is the base directory for the SAP system. For <code>/&lt;sapmnt&gt;</code> you can use a directory of your choice. If you do not specify a directory, SAPinst creates a directory named <code>sapmnt</code> by default. Do not add <code>&lt;SAPSID&gt;</code> as subdirectory because the installer adds this directory automatically.</td>
</tr>
</tbody>
</table>

**Example**

If you enter `/sapmount` for `/<sapmnt>` and `KB1` for `<SAPSID>` during the input phase of the installation, the installer creates the directory `/sapmount/KB1`.

For more information, see Setting Up File Systems and Raw Devices | page 66. |

<table>
<thead>
<tr>
<th>SAP MaxDB file systems</th>
<th>SAP MaxDB root directory, <code>/sapdb</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For file system installations: locations of SAP data and log volumes</td>
</tr>
<tr>
<td></td>
<td>For raw device installations: locations of raw devices for data and log volumes</td>
</tr>
</tbody>
</table>

Parameters Relevant for the Database

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database ID</td>
<td>Identifier for the database</td>
</tr>
<tr>
<td>Database schema</td>
<td>SAP&lt;SAPSID&gt;DB</td>
</tr>
<tr>
<td>Database operating system users and groups</td>
<td>SAP MaxDB software owner (default values):</td>
</tr>
<tr>
<td></td>
<td>User: <code>sdb</code></td>
</tr>
<tr>
<td></td>
<td>Group: <code>sdba</code></td>
</tr>
<tr>
<td></td>
<td>SAP MaxDB database owner: <code>sqd&lt;dbsid&gt;</code></td>
</tr>
</tbody>
</table>

### 3.2 Hardware and Software Requirements

You check that your hosts meet the hardware and software requirements for your operating system and the SAP instances.

**Caution**

If your hosts do not fully meet the requirements, you might experience problems when working with the SAP system.

**Prerequisites**

- Contact your OS vendor for the latest OS patches.
- Make sure that the host name meets the requirements listed in SAP Note 611361.
3.2 Hardware and Software Requirements

- Check your keyboard definitions.
- If you want to install a printer on a host other than the central instance host (for example, on a separate database instance host), make sure that the printer can be accessed under UNIX.

**Process Flow**

1. Check the *Product Availability Matrix* at [http://service.sap.com/pam](http://service.sap.com/pam) for supported operating system releases.

2. Check the hardware and software requirements using:
   - **The Prerequisite Checker:**
     - Standalone (optional) before the installation process
       For more information, see *Running the Prerequisite Checker Standalone* [page 47].
     - Integrated in the installation tool (mandatory) as part of the installation process
       For more information, see *Running SAPinst* [page 89].

   ![Note]

   For the most recent updates to the Prerequisite Checker, always check SAP Note 855498.

- The hardware and software requirements checklists for:
  - *Linux* [page 48]
  - *Standard system* [page 49]

   ![Note]

   These requirements also apply if you want to install the Application Sharing Server as an Optional Standalone Unit.

  - *Distributed system* [page 50]
  - *High availability system* [page 53]
  - If you want to install additional application server instances, check the requirements for an *additional application server instance* [page 57].
  - If you want to install the Application Sharing Server as an optional standalone unit, see the requirements for a *standard system* [page 49].
  - If you want to install the host agent on a host that does not have an SAP component, check the requirements for the *host agent as a separate installation* [page 58].

3. If you are installing a *production* system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:
     For more information about the SAP Quick Sizer and available sizing guides, see the *Master Guide – SAP NetWeaver 7.0* at [http://service.sap.com/installnw70](http://service.sap.com/installnw70) Planning.
   - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
     - The set of applications to be deployed
3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)

Before installing your SAP system, you can run the Prerequisite Checker in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances.

**Recommendation**

We recommend that you use both the Prerequisite Checker and the requirements tables for reference.

**Note**

When installing your SAP system, SAPInst automatically starts the Prerequisite Checker and checks the hardware and software requirements in the background.

**Prerequisites**

- You have prepared the Installation Master DVD on the required installation host [page 80].
- You make sure that the required prerequisites are met before starting SAPInst [page 89].

**Procedure**

1. You start SAPInst [page 89].
2. On the Welcome screen, choose <SAP System> > Software Life-Cycle Options > Additional Preparation Tasks > Prerequisites Check.
3. Follow the instructions in the SAPInst dialogs and enter the required parameters.

**Note**

For more information about each parameter, position the cursor on the parameter field and choose F1 in SAPInst.

When you have finished, the Parameter Summary screen appears summarizing all parameters you have entered. If you want to make a change, select the relevant parameters and choose Revise.

4. To start the Prerequisite Checker, choose Start.

**Result**

The Prerequisite Check Results screen displays the results found. If required, you can also check the results in file prerequisite_checker_results.html, which you can find in the installation directory.
3.2 Hardware and Software Requirements

3.2.2 Requirements for Linux

The host machine must meet the following requirements:

**Note**
- The information here is **not** intended to replace the documentation of the Linux operating system (OS).
- For more information about the installation on Linux, see [SAP Note 171356](https://support.sap.com/note/171356).

### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD drive</td>
<td>■ DVD drive&lt;br&gt;○ ISO 9660 compatible&lt;br&gt;○ Must be connected locally to your central instance host.&lt;br&gt;○ You can configure multiple DVD drives. For more information, see <em>Mounting a CD / DVD for Linux</em> [page 128].</td>
</tr>
</tbody>
</table>
| Disks       | For data security reasons, distribution over five disks is recommended (RAID5).<br>If an advanced disk array is available (for example, RAID), contact your hardware vendor to make sure that the data security requirements are covered by this technology.<br>To print and change the partitioning of the first SCSI disk, enter this command:<br>```
/sbin/fdisk /dev/sda
```
To print and change the partitioning of a RAID device enter commands specific to your hardware.<br>**Example**<br>Here are some examples of hardware-specific commands for RAID devices:<br>```
/sbin/fdisk /dev/rd/c0d0
/sbin/fdisk /dev/ida/c0d0
```
| RAM         | To display RAM size in KB, enter the following command: `free` |
| CPU         | The recommended minimum hardware is either two physical single core processors or one physical dual core processor. |

### Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system version</td>
<td>Check the operating system version with this command: <code>cat /etc/*-release</code></td>
</tr>
<tr>
<td>Linux kernel version</td>
<td>Check the Linux kernel version with this command: <code>uname -r</code></td>
</tr>
<tr>
<td>Linux kernel parameter settings</td>
<td>Check the Linux kernel parameter settings with this command: <code>/sbin/sysctl -a</code></td>
</tr>
</tbody>
</table>
### 3.2 Hardware and Software Requirements

#### Values and Activities

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activated hardware drivers</td>
<td>Check the activated hardware drivers with this command:</td>
</tr>
<tr>
<td></td>
<td><code>lsmod</code></td>
</tr>
<tr>
<td>Shared memory file system</td>
<td>Check the size of the shared memory file system with this command:</td>
</tr>
<tr>
<td></td>
<td><code>df -k /dev/shm</code></td>
</tr>
<tr>
<td>Network File System (NFS)</td>
<td>Check whether NFS is running as follows:</td>
</tr>
<tr>
<td></td>
<td>- On Red Hat Linux</td>
</tr>
<tr>
<td></td>
<td><code>service nfs status</code></td>
</tr>
<tr>
<td></td>
<td><code>service portmap status</code></td>
</tr>
<tr>
<td></td>
<td>- On SUSE LINUX</td>
</tr>
<tr>
<td></td>
<td><code>rcnfs status</code></td>
</tr>
<tr>
<td></td>
<td><code>rcnfsserver status</code></td>
</tr>
<tr>
<td></td>
<td><code>rcportmap status</code></td>
</tr>
<tr>
<td>Routing information</td>
<td>To check routing information, enter the following command:</td>
</tr>
<tr>
<td></td>
<td><code>netstat -r</code></td>
</tr>
<tr>
<td>System language</td>
<td>For the installation, you must choose English as the operating system language on all</td>
</tr>
<tr>
<td></td>
<td>Linux hosts that run SAP software.</td>
</tr>
<tr>
<td>National Language Support (NLS)</td>
<td>To display available locales, enter the following command:</td>
</tr>
<tr>
<td></td>
<td><code>locale -a</code></td>
</tr>
<tr>
<td></td>
<td>Check the output for locales such as the following:</td>
</tr>
<tr>
<td></td>
<td><code>de_DE</code>, <code>en_US</code></td>
</tr>
<tr>
<td></td>
<td>10 locales are available as an attachment of SAP Note 171356.</td>
</tr>
<tr>
<td>C compiler</td>
<td>The C compiler gcc must be installed. To check, enter this command:</td>
</tr>
<tr>
<td></td>
<td>`rpm -qa</td>
</tr>
<tr>
<td></td>
<td>Make sure that the output of this command contains a gcc RPM package.</td>
</tr>
</tbody>
</table>

#### Other Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer</td>
<td>Check the status of spooling queues and printers with the following command:</td>
</tr>
<tr>
<td></td>
<td><code>lpc status</code></td>
</tr>
<tr>
<td></td>
<td>Check whether you can print a file with this command:</td>
</tr>
<tr>
<td></td>
<td><code>lpr -P&lt;printer_name&gt; &lt;test_file&gt;</code></td>
</tr>
<tr>
<td>Network</td>
<td>Test the network connection to the database server with the following command:</td>
</tr>
<tr>
<td></td>
<td><code>ping -c 10 &lt;db_server_name&gt;</code></td>
</tr>
</tbody>
</table>

### 3.2.3 Requirements for a Standard System

If you want to install a standard system – that is, all instances reside on one host – the host must meet the following requirements:
### 3.2.4 Requirements for a Distributed System

The following sections provide information about the hardware and software requirements for a distributed system, where the following SAP instances can reside on different hosts:

- **Central services instance** [page 51]
- **Database instance** [page 51]
- **Primary application server instance** [page 52]

**Note**

If you install multiple SAP system instances on one host, you need to add up the requirements.
3.2.4.1 Requirements for a Central Services Instance

The central services instance host must meet the following requirements for the central services instance:

**Hardware Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space</td>
<td>■ Hard disk drives with sufficient space for the central services instance</td>
</tr>
<tr>
<td></td>
<td>For more information, see SAP Directories [page 67].</td>
</tr>
<tr>
<td></td>
<td>■ 4.3 GB of temporary disk space for every required installation DVD that you</td>
</tr>
<tr>
<td></td>
<td>have to copy to a local hard disk</td>
</tr>
<tr>
<td></td>
<td>For more information, see Preparing the Installation DVDs [page 80].</td>
</tr>
<tr>
<td></td>
<td>■ 1.2 GB of temporary disk space for the installation.</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td>Swap Space</td>
<td>You need hard disk drives with sufficient space for swap. The required swap space</td>
</tr>
<tr>
<td></td>
<td>can be calculated as follows: 2 * RAM, at least 20 GB</td>
</tr>
<tr>
<td></td>
<td>For more information, see SAP Note 171356.</td>
</tr>
</tbody>
</table>

**Software Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System</td>
<td>Network File System (NFS) must be installed.</td>
</tr>
<tr>
<td>(NFS)</td>
<td></td>
</tr>
</tbody>
</table>

3.2.4.2 Requirements for the Database Instance

The database host must meet the following requirements:

**Hardware Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk space</td>
<td>■ Space requirements of the SAP data file systems, see the following file:</td>
</tr>
<tr>
<td></td>
<td>&lt;Export_DVD&gt;/DATA_UNITS/EXPORT_1/DB/ADA/DBSIZE.XML</td>
</tr>
<tr>
<td></td>
<td>The XML table in this file contains a field called fDevSize, which</td>
</tr>
<tr>
<td></td>
<td>contains the size in MB of the element indicated in the previous field, fDevName.</td>
</tr>
<tr>
<td></td>
<td>This shows you the size of the data (DBDATADEV) and the log (DBLOGDEV) volumes.</td>
</tr>
<tr>
<td>Note</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The values listed in DBSIZE.XML are only for guidance.</td>
</tr>
</tbody>
</table>

[51/146]
### 3.2 Hardware and Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For more information about the required disk space per file system, see <em>Setting Up File Systems</em> [page 66]. For security reasons (system failure), the file systems must be distributed physically over at least three (but five are recommended) disks.</td>
</tr>
</tbody>
</table>
|             | Database software:  
|             | - Version 7.6: 500 MB  
|             | - Version 7.7: 700 MB  
|             | - 4.5 GB of temporary disk space for every required installation DVD you have to copy to a local hard disk.  
|             | - 1.2 GB of temporary disk space for the installation |
| RAM         | 1 GB |
| Swap space  | - Recommended: 3*RAM + 4.5 GB  
|             | - Minimum: 2*RAM + 4 GB  
|             | - Maximum: 15 GB |

### Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System (NFS)</td>
<td>If application servers are installed decentralized, Network File System (NFS) must be installed.</td>
</tr>
<tr>
<td>Required fonts and code pages</td>
<td>Make sure that the required fonts and code pages are installed.</td>
</tr>
<tr>
<td>National Language Support (NLS)</td>
<td>Make sure that National Language Support (NLS) and corresponding <em>saplocales</em> are installed.</td>
</tr>
</tbody>
</table>
| Operating systems | - For supported operating system releases, see [http://service.sap.com/platforms](http://service.sap.com/platforms) Product Availability Matrix.  
|             | - Contact your operating system vendor for the latest OS patches. |

### 3.2.4.3 Requirements for the Primary Application Server Instance

The host where the primary application server instance runs must meet the following requirements:
### 3.2 Hardware and Software Requirements

#### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space</td>
<td>- Hard disk drives with sufficient space for the primary application server instance. For more information, see <em>SAP Directories</em> [page 67].</td>
</tr>
<tr>
<td></td>
<td>- 4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk. For more information, see <em>Preparing the Installation DVDs</em> [page 80].</td>
</tr>
<tr>
<td></td>
<td>- 1.2 GB of temporary disk space for the installation.</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td>Swap Space</td>
<td>Hard disk drives with sufficient space for swap: 2 * RAM, at least 20 GB For more information, see <em>SAP Note 171356</em>.</td>
</tr>
</tbody>
</table>

#### Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System (NFS)</td>
<td>If application servers are installed decentralized, Network File System (NFS) must be installed.</td>
</tr>
<tr>
<td>Required fonts and code pages</td>
<td>Make sure that the required fonts and code pages are installed.</td>
</tr>
<tr>
<td>National Language Support (NLS)</td>
<td>Make sure that National Language Support (NLS) and corresponding <em>saplocales</em> are installed.</td>
</tr>
</tbody>
</table>

### 3.2.5 Requirements for a High Availability System

The following sections provide information about the hardware and software requirements for a high-availability system, where the following SAP instances can reside on different hosts or on a switchover cluster infrastructure:

- *Enqueue replication server instances* [page 54]
- *Database instance* [page 55]
- *Primary application server instance* [page 56]

### 3.2.5.1 Requirements for a Central Services Instance

The central services instance host must meet the following requirements for the central services instance (SCS):
3.2 Hardware and Software Requirements

**Hardware Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| Hard disk space   | - Hard disk drives with sufficient space for the central services instance  
                      - For more information, see SAP Directory [page 67].  
                      - 4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk  
                      - For more information, see Preparing the Installation DVD; [page 80].  
                      - 1.2 GB of temporary disk space for the installation. |
| Minimum RAM       | 1 GB                                                                                                                                                                                                                  |
| Swap Space        | You need hard disk drives with sufficient space for swap. The required swap space can be calculated as follows: 2 \* RAM, at least 20 GB  
                      - For more information, see SAP Note 171356.                                                                                                                  |

**Software Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System (NFS)</td>
<td>Network File System (NFS) must be installed.</td>
</tr>
</tbody>
</table>

**3.2.5.2 Requirements for an Enqueue Replication Server Instance**

The host on which an enqueue replication server instance runs must meet the following requirements:

**Note**

The enqueue replication server instance is only required for high-availability systems.  
You need one ERS for each Java SCS installed in your system.
### Hardware and Software Requirements

#### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space</td>
<td>- Hard disk drives with sufficient space for the central services instance</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>SAP Directories</em> [page 63].</td>
</tr>
<tr>
<td></td>
<td>- 4.3 GB of temporary disk space for every required installation DVD that you</td>
</tr>
<tr>
<td></td>
<td>have to copy to a local hard disk</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>Preparing the Installation DVDs</em> [page 80].</td>
</tr>
<tr>
<td></td>
<td>- 1.2 GB of temporary disk space for the installation.</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td>Swap Space</td>
<td>You need hard disk drives with sufficient space for swap. The required swap space</td>
</tr>
<tr>
<td></td>
<td>can be calculated as follows:</td>
</tr>
<tr>
<td></td>
<td>[2 \times \text{RAM}, \text{at least 20 GB}]</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>SAP Note</em> [171356].</td>
</tr>
</tbody>
</table>

#### Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System (NFS)</td>
<td>Network File System (NFS) must be installed.</td>
</tr>
</tbody>
</table>

**End of: HA (UNIX)**

### 3.2.5.3 Requirements for the Database Instance

The database host must meet the following requirements:

#### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk space</td>
<td>- Space requirements of the SAP data file systems, see the following file:</td>
</tr>
<tr>
<td></td>
<td>&lt;Export_DVD&gt;/DATA_UNITS/EXPORT_1/DB/ADA/DBSIZE.XML</td>
</tr>
<tr>
<td></td>
<td>The XML table in this file contains a field called fDevSize, which</td>
</tr>
<tr>
<td></td>
<td>contains the size in MB of the element indicated in the previous field,</td>
</tr>
<tr>
<td></td>
<td>fDevName. This shows you the size of the data (DBDATADEV) and the</td>
</tr>
<tr>
<td></td>
<td>log (DBLOGDEV) volumes.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>The values listed in DBSIZE.XML are only for guidance.</td>
</tr>
<tr>
<td></td>
<td>For more information about the required disk space per file system,</td>
</tr>
<tr>
<td></td>
<td>see <em>Setting Up File Systems</em> [page 66].</td>
</tr>
</tbody>
</table>
### 3.2.5.4 Requirements for the Primary Application Server Instance

The host where the primary application server instance runs must meet the following requirements:

#### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hard disk drives with sufficient space for the primary application server instance. For more information, see <em>SAP Directories</em> [page 67].</td>
</tr>
<tr>
<td></td>
<td>• 4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk. For more information, see <em>Preparing the Installation DVDs</em> [page 80].</td>
</tr>
<tr>
<td></td>
<td>• 1.2 GB of temporary disk space for the installation.</td>
</tr>
</tbody>
</table>

#### Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System (NFS)</td>
<td>If application servers are installed decentralized, Network File System (NFS) must be installed.</td>
</tr>
<tr>
<td>Required fonts and code pages</td>
<td>Make sure that the required fonts and code pages are installed.</td>
</tr>
<tr>
<td>National Language Support (NLS)</td>
<td>Make sure that National Language Support (NLS) and corresponding <em>saplocales</em> are installed.</td>
</tr>
<tr>
<td>Operating systems</td>
<td>• For supported operating system releases, see <a href="http://service.sap.com/platforms">http://service.sap.com/platforms</a> <em>Product Availability Matrix</em>.</td>
</tr>
<tr>
<td></td>
<td>• Contact your operating system vendor for the latest OS patches.</td>
</tr>
</tbody>
</table>
Preparation

3.2 Hardware and Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td>Swap Space</td>
<td>Hard disk drives with sufficient space for swap: 2 * RAM, at least 20 GB</td>
</tr>
<tr>
<td></td>
<td>For more information, see SAP Note 171356.</td>
</tr>
</tbody>
</table>

Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System (NFS)</td>
<td>If application servers are installed decentralized, Network File System (NFS) must be installed.</td>
</tr>
<tr>
<td>Required fonts and code pages</td>
<td>Make sure that the required fonts and code pages are installed.</td>
</tr>
<tr>
<td>National Language Support (NLS)</td>
<td>Make sure that National Language Support (NLS) and corresponding saplocales are installed.</td>
</tr>
</tbody>
</table>

3.2.6 Requirements for an Additional Application Server Instance

The additional application server host must meet the following requirements:

Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space</td>
<td>Hard disk drives with sufficient space for the additional application server instance. For more information, see SAP Directories [page 67].</td>
</tr>
<tr>
<td></td>
<td>4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk. For more information, see Preparing the Installation DVDs [page 80].</td>
</tr>
<tr>
<td></td>
<td>1.2 GB of temporary disk space for the installation.</td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
</tr>
<tr>
<td>Swap Space</td>
<td>You need hard disk drives with sufficient space for swap. The required swap space can be calculated as follows: 2 * RAM, at least 20 GB For more information, see SAP Note 171356.</td>
</tr>
</tbody>
</table>
3.2 Hardware and Software Requirements

Software Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP kernel</td>
<td>Make sure that the SAP kernel of the primary application server instance has at least the patch level of the SAP kernel on the SAP Kernel DVD that is used for the installation of the additional application server instance. We recommend that you apply the most current SAP kernel from the SAP Service Marketplace at <a href="http://service.sap.com/swdc">http://service.sap.com/swdc</a>.</td>
</tr>
<tr>
<td>Network File System (NFS)</td>
<td>Network File System (NFS) must be installed.</td>
</tr>
</tbody>
</table>

### 3.2.7 Requirements for a Standalone Host Agent

If you want to install a standalone host agent, the installation host has to meet the following requirements:

**Hardware Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| Hard Disk Space   | - Minimum disk space  
                   |   For information about the required disk space per file system, see [Setting Up File Systems](page 66).                                                                                                               |
|                   |   4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk. For more information, see [Preparing the Installation DVDs](page 80). |
|                   |   1.2 GB of temporary disk space for the installation.                                                                                                                                                                 |
| Minimum RAM       | 0.5 GB                                                                                                                                                                                                                 |
| Swap space        | You need hard disk drives with sufficient space for swap. The required swap space can be calculated as follows:  
                   |   2 * RAM, at least 20 GB  
                   |   For more information, see [SAP Note 171356](http://service.sap.com/swdc).                                                                                                                                 |

**Software Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network File System (NFS)</td>
<td>Network File System (NFS) must be installed.</td>
</tr>
</tbody>
</table>
3.2.8 Checking and Modifying the Linux Kernel

If you are using a Linux kernel version certified by SAP, you do not need to modify the Linux kernel. To check the Linux kernel version, enter this command:

```
uname -a
```

For more information about the Linux kernel versions certified by SAP, see SAP Note 171356. Check the Linux kernel parameters for your Linux distribution according to one of the following SAP Notes:

- RHEL4: SAP Note 722273
- RHEL5: SAP Note 1048303
- SLES9: SAP Note 797084
- SLES10: SAP Note 958253

3.2.9 Setting up Swap Space for Linux

You created partitions of the type “swap” when you scheduled the hard disk(s) during the installation of your Linux distribution.

The Linux kernel usually does not require much swap space, since other limits have already been reached before the swap space has reached full capacity (“late swap allocation”). However, if you notice the need for more swap space when using SAP software, you can use the distribution-specific tools to increase your swap space at any time.

Prerequisites

Make sure that you have already configured the UNIX kernel and that you have met the other prerequisites as described in Requirements for Linux [page 48] and in Checking and Modifying the Linux Kernel [page 59].

Procedure

1. To check the allocated swap space, enter the following command:

```
swapon -s
```

   Recommended total size: Twice the main memory structure (2 x RAM), at least 20 GB.
   If possible, use an entire physical disk as a swap space partition.

2. If required, configure swap space as follows:

   - On Red Hat Linux:
     Check the documentation provided by Red Hat.
   - On SUSE LINUX, enter one of the following commands:
3.3 Specifying the Virtual Host Name

If you want to use a virtual host name, you can set the environment variable `SAPINST_USE_HOSTNAME` to specify the virtual host name before you start SAPinst.
You can also specify the virtual host name by starting SAPinst [page 89] with an equivalent parameter in the command line.

**Procedure**
Set `SAPINST_USE_HOSTNAME` to the virtual host name of the machine on which you are installing an SAP instance as follows:

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bourne shell (sh)</td>
<td><code>SAPINST_USE_HOSTNAME=&lt;directory&gt;</code></td>
</tr>
<tr>
<td></td>
<td><code>export SAPINST_USE_HOSTNAME</code></td>
</tr>
<tr>
<td>C shell (csh)</td>
<td><code>setenv SAPINST_USE_HOSTNAME &lt;directory&gt;</code></td>
</tr>
<tr>
<td>Korn shell (ksh)</td>
<td><code>export SAPINST_USE_HOSTNAME=&lt;directory&gt;</code></td>
</tr>
</tbody>
</table>

**More Information**
For more information about the use of virtual TCP/IP host names, see SAP Note [962955](#).

[Only valid for: HA (UNIX)]

3.4 Performing Switchover Preparations for High Availability

Do the following to prepare the switchover cluster:

**Procedure**
1. Make sure that the virtual host name [page 89] can be correctly resolved in your Domain Name System (DNS) setup.
2. Assign the virtual IP addresses and host names for the SCS instance, and (if required) NFS to appropriate failover groups.
3.5 Creating Operating System Users and Groups

During the installation, SAPinst checks all required accounts (users, groups) and services on the local machine. SAPinst checks whether the required users and groups already exist. If not, it creates new users and groups as necessary.

If you do not want SAPinst to create operating systems users, groups, and services automatically, you can optionally create them before the installation. This might be the case if you use central user management such as Network Information System (NIS).

SAPinst checks if the required services are available on the host and creates them if necessary. See the log messages about the service entries and adapt the network-wide (NIS) entries accordingly.

SAPinst checks the NIS users, groups, and services using NIS commands. However, SAPinst does not change NIS configurations.

Recommendation

For a distributed or a high-availability system, we recommend that you distribute account information (operating system users and groups) over the network, for example by using Network Information Service (NIS).

Caution

All users must have identical environment settings. If you change the environment delivered by SAP, such as variables, paths, and so on, we do not assume responsibility.

If you want to use global accounts that are configured on a separate host, you can do this in one of the following ways:

- You start SAPinst and choose Software Life-Cycle Tasks > Additional Preparation Tasks > Operating System Users and Groups. For more information, see Running SAPinst (page 89).
- You create operating system users and groups manually as described in Creating Linux Groups and Users (Optional) (page 63).

Operating System Users and Groups

SAPinst chooses available operating system user IDs and group IDs unless you are installing an additional application server instance. On an additional application server instance you have to enter the same IDs as on the host of the primary application server instance.
Do not delete any shell initialization scripts in the home directory of the OS users. This applies even if you do not intend to use the shells that these scripts are for.

If you create the sdb user manually, make sure that you lock it for the installation. SAPinst normally locks this user after it has been created.

The user ID (UID) and group ID (GID) of each operating system user and group must be identical for all servers belonging to the same SAP system.
This does not mean that all users and groups have to be installed on all SAP servers.

Users and Groups of the SAP System

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
<th>Additional Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;sapid&gt;adm</td>
<td>sapsys</td>
<td>sapinst</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td>sapadm</td>
<td>sapsys</td>
<td>sapinst</td>
<td>Host Agent administrator</td>
</tr>
<tr>
<td>sqd&lt;dbsid&gt;</td>
<td>sapsys</td>
<td>sapinst, sdba</td>
<td>Owner of database instance &lt;DBSID&gt;</td>
</tr>
<tr>
<td>sdb</td>
<td>sdba</td>
<td></td>
<td>Database software owner</td>
</tr>
</tbody>
</table>

Users and Groups of the SAP System

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
<th>Additional Group</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapadm</td>
<td>sapsys</td>
<td>sapinst</td>
<td>Host Agent administrator</td>
</tr>
</tbody>
</table>

If these operating system users already exist, make sure that they are assigned to group sapinst.

If you install a distributed system and you use local operating system user accounts instead of central user management (for example, NIS), user <sapid>adm, sapadm, and the database operating system user must have the same password on all hosts.
Groups and Members of the SAP System Users

<table>
<thead>
<tr>
<th>Groups</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapsys</td>
<td>&lt;sapsid&gt;adm, sapadm, sqd&lt;dbsid&gt;</td>
</tr>
<tr>
<td>sapinst</td>
<td>&lt;sapsid&gt;adm, sapadm, sqd&lt;dbsid&gt;</td>
</tr>
<tr>
<td>sdba</td>
<td>sqd&lt;dbsid&gt;, sdb</td>
</tr>
</tbody>
</table>

Groups and Members of the Standalone Host Agent User

<table>
<thead>
<tr>
<th>Groups</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapsys</td>
<td>sapadm</td>
</tr>
<tr>
<td>sapinst</td>
<td>sapadm</td>
</tr>
</tbody>
</table>

### 3.5.1 Creating Linux Groups and Users (Optional)

You can manage Linux users with one of the following graphical tools:

- Red Hat Linux:
  - RHEL4 and higher: `system-config-users`
- SUSE Linux:
  - SLES9 and higher: `yast` or `yast2`

<table>
<thead>
<tr>
<th>Task</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating groups</td>
<td><code>groupadd</code></td>
</tr>
<tr>
<td>Modifying groups</td>
<td><code>groupmod</code></td>
</tr>
<tr>
<td>Deleting groups</td>
<td><code>groupdel</code></td>
</tr>
<tr>
<td>Creating users</td>
<td><code>useradd</code></td>
</tr>
<tr>
<td>Modifying users</td>
<td><code>usermod</code></td>
</tr>
<tr>
<td>Deleting users</td>
<td><code>userdel</code></td>
</tr>
</tbody>
</table>

### 3.6 Preparing User Management for an External ABAP System

For a Java system, you can also deploy user management for an external ABAP system. In this case, you configure the User Management Engine (UME) of Application Server Java (AS Java) for the user management of a separate ABAP system.
If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each system. You can take one of the following approaches:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
</tbody>
</table>
| All Java systems use the same configuration | You create the users only once and enter the same information for every Java systems that you install. | Interdependencies between the connected engines:  
  - If you change the password of any of the users on the ABAP system, this change affects all connected engines.  
  - If you change the administrator user's password, you must also change the password in secure storage on all of the connected Java systems. |

**Recommendation**

For security reasons, we recommend the first approach.

The procedures below assume that you are using the first approach.

**Prerequisites**

- The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.
- In transaction PFCG, check that the roles SAP_BC_JSF_COMMUNICATION and SAP_BC_JSF_COMMUNICATION_R0 exist and make sure that their profiles are generated.
- In transaction PFCG, check that the roles SAP_J2EE_ADMIN, SAP_J2EE_GUEST and SAP_BC_FP_ICF exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.
- For more information, see the SAP Library [page 12]:  
  - Function-Oriented View  
  - Security  
  - Identity Management  
  - Identity Management of the Application Server Java  
  - User Management Engine  

**Note**

For more information about role maintenance, see the SAP Library [page 12] at  
- Function-Oriented View  
- Security  
- Identity Management  
- Identity Management of the Application Server ABAP  
- AS ABAP Authorization Concept  

**Administration of the ABAP system**

Perform the following administration steps in the ABAP system:
1. In transaction SU01, create a new communication user and assign it to the role `SAP_BC_JSF_COMMUNICATION_RO`.

   **Recommendation**
   
   We recommend that you assign this user the role `SAP_BC_JSF_COMMUNICATION_RO` for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role `SAP_BC_JSF_COMMUNICATION` instead.
   
   We recommend that you name the user `SAPJSF_<SAPSID_Java_System>`. You can use any password.

   In addition, to make sure that this user can only be used for communication connections between systems and not as a dialog user, assign it the type `Communications` under `Logon data`.

2. In transaction SU01, create a new dialog user and assign it to role `SAP_J2EE_ADMIN`. This is your administrator user in AS Java.

   **Recommendation**
   
   We recommend that you name the user `J2EE_ADM_<SAPSID_Java_System>`. You can use any password.

   **Caution**
   
   Log on to the SAP system once with this user to change its initial password. Since the installer of AS Java verifies this password, the installation fails if this password is initial.

3. In transaction SU01, create a new dialog user and assign it to role `SAP_J2EE_GUEST`. This is your guest user in AS Java.

   **Recommendation**
   
   We recommend that you name the user `J2EE_GST_<SAPSID_Java_System>`. You can use any password.
   
   Since this user is only used for anonymous access to the system, we recommend you to deactivate the password and, if required, lock it after installation to prevent anyone from using it for explicit named logons.

4. In transaction SU01, create the following dialog users:

   **Caution**
   
   You must have changed the initial passwords of these users **before** you start the installation of the Java system.

   - Users for Adobe Document Services (ADS) (optional):
3.7 Setting Up File Systems and Raw Devices

- **ADSLuser:**
  In transaction PFCG, assign the role ADSCallers to this user.

- **ADSL.Agent:**
  In transaction PFCG, assign the role SAP_BC_FP_ICF to this user.

**SLD Data supplier user (optional):**
You only have to create this user if you want to install System Landscape Directory (SLD). The SLD data supplier user name that you enter later on during the Java system installation must be identical to this user.

⚠️ Recommendation
We recommend that you name this user SLDSSUSER

- **SLD ABAP API user (optional):**
  You only have to create this user if you want to install System Landscape Directory (SLD). The SLD ABAP API user name that you enter later on during the Java system installation must be identical to this user.

⚠️ Recommendation
We recommend that you name this user SLDAPIUSER

**Note**
For more information about SLD users and security roles, see the [SAP Library](#) at [Administrator’s Guide](#) Technical Operations for SAP NetWeaver Software Life-Cycle Management Configuring, Working with and Administering System Landscape Directory Administering the SLD.

### Activities for the Java System
Perform the following steps in the Java system:

1. **Before** the installation of the Java system, make sure that you have the correct user names and passwords of the users listed above for the separate ABAP system.

2. **During** the installation of the Java system, make sure that you enter the correct users and passwords in the corresponding SAPinst dialogs.

### 3.7 Setting Up File Systems and Raw Devices
The following section(s) describe the directory structures for the SAP system, how to set up SAP file systems for the SAP system and, if required, raw devices on operating system level:

⚠️ Note
The installation of any SAP system does not require a special file system setup or separate partitions.
3.7 Setting Up File Systems and Raw Devices

- SAP Directories [page 67]
- Performing Switchover Preparations for High Availability [page 60]
- MaxDB Directories [page 71]
- Host Agent Directories [page 71]
- Setting Up File Systems for High-Availability [page 72]
- Configuring Network File System for High Availability [page 74]
- Setting Up Standard File Systems for Linux [page 76]

### 3.7.1 SAP Directories

Here we describe the directories of a typical SAP system. SAPInst creates the following types of directories:

- Physically shared directories, which reside on the global host and are shared by Network File System (NFS)
- Logically shared directories, which reside on the local host(s) with symbolic links to the global host
- Local directories, which reside on the local host(s)

#### Features

The following figure shows the directory structure of the SAP system:

**Figure 12: Directory Structure for a Java System**

```
+-----------------+-----------------+-----------------+
| Physically shared directories | Logically shared directories | Local directories |
+-----------------+-----------------+-----------------+
| / (root)        |                  |                 |
+-----------------+-----------------+-----------------+
| <sapmnt>        |                  |                 |
|                  | <SAPSID>        |                 |
|                 | <SAPSID>        |                 |
|                 | trans           |                 |
|                 | global          | sys             |
|                 | profile         | profile         |
|                 | exe             | exe             |
|                 | <platform>      |                 |
|                 | <codepage>      |                 |
|                 |                 |                 |
| log             | data            | log             |
| data            | work            | data            |
| work            | j2ee            | work            |
| j2ee            | exe             | exe             |
| exe             |                 |                 |
|                 | <instance>      |                 |
|                 | SCS<No>         |                 |
|                 | [ERS<No>]:      |                 |
|                 |                 |                 |
+-----------------+-----------------+-----------------+
```

**Key**

- Symbolic link
- Replication by sapcpe
- [ERS<No>]: High availability only
- <codepage>: Unicode
3.7 Setting Up File Systems and Raw Devices

**Figure 13:** Directory Structure for the Diagnostics Agent

**Physically Shared Directories**

SAPInst creates the following directories:

- The directory `/<sapmnt>/<SAPSID>`, which contains SAP kernel and related files, is created on the first installation host. Normally, the first installation host is the host on which the central services instance is to run, but you can also choose another host for `/<sapmnt>/<SAPSID>`. You need to manually share this directory with Network File System (NFS) and — for a distributed system — mount it from the other installation hosts. SAPInst creates the following shared directories during the SAP system installation:
  - **global**
    - Contains globally shared data
  - **profile**
    - Contains the profiles of all instances
  - **exe**
    - Contains executable kernel programs
- The directory `/usr/sap/trans`, which is the global transport directory. If you want to use an existing transport directory, you have to mount it before you install the application server instance in question. Otherwise SAPInst creates `/usr/sap/trans` locally. For more information, see *Exporting and Mounting the Global Transport Directory* [page 77]
### Directory Setup

<table>
<thead>
<tr>
<th>Directory</th>
<th>Required Disk Space</th>
</tr>
</thead>
</table>
| `<sapmnt>/SAPSID>`               | - Primary application server instance: 1.5 GB  
|                                  | - Central services instance: 1.0 GB                                                 |
| `/usr/sap/trans`                  | This value heavily depends on the use of your SAP system.  
|                                  | For production systems, we recommended to use as much free space as available (at least 2.0 GB), because the space requirement normally grows dynamically.  
|                                  | For the installation, it is sufficient to use 200 MB for each SAP system instance. You can enlarge the file system afterwards. |

#### Logically Shared Directories

SAPinst creates the directory `/usr/sap/<SAPSID>/SYS` on each host. The subdirectories contain symbolic links to the corresponding subdirectories of `/<sapmnt>/<SAPSID>` on the first installation host, as shown in the figure above.

Whenever a local instance is started, the sapcpe program checks the executables against those in the logically shared directories and, if necessary, replicates them to the local instance.

#### Local Directories (SAP System)

The directory `/usr/sap/<SAPSID>` contains files for the operation of a local instance as well as symbolic links to the data for one system.

This directory is physically located on each host in the SAP system and contains the following subdirectories:

- **SYS**

  Note

  The subdirectories of `/usr/sap/<SAPSID>/SYS` have symbolic links to the corresponding subdirectories of `/<sapmnt>/<SAPSID>`, as shown in the figure above.

- `<INSTANCE>` for each instance installed on the host

  The instance-specific directories have the following names:

  - The directory both of the primary application server instance and of an additional application server instance is called `J<Instance_Number>`.
  - The directory of the central services instance is called `SCS<Instance_Number>`.
  - The directory of the Enqueue Replication Server instance is called `ERS<Instance_Number>`.

  Only valid for: HA (UNIX)

  End of: HA (UNIX)
Local Directories (Diagnostics Agent)

The directory `/usr/sap/<SAPSID>` contains files for the operation of a local Diagnostics Agent instance.

This directory is physically located on each host in the SAP system and contains the following subdirectories:

- **exe**
  Contains the following global scripts:
  - `smdstart.sh`
    This script is used to start one or more Diagnostics Agent(s) available in the system landscape.
  - `smdstop.sh`
    This script is used to stop one or more Diagnostics Agent(s) available in the system landscape.
  - `smdadmin.sh`
    This script is used to manage one or more Diagnostics Agent(s) available in the system landscape.

- **<INSTANCE>**
  The directory of the Diagnostics Agent is called `DIA<Instance_Number>`

This directory contains the Instance-specific data of the Diagnostics Agent.

Contains the following subdirectories:

- **profile**
  Contains the `smd.properties` file

- **sapinst**
  Contains log files of the installation

- **script**
  Contains the following local scripts:
  - `smdstart.sh`
    This script is used to start the local Diagnostics Agent.
  - `smdstop.sh`
    This script is used to stop the local Diagnostics Agent.
  - `smdadmin.sh`
    This script is used to manage the local Diagnostics Agent.

- **SMDAgent**
  Contains the Diagnostics Agent software and `properties` files.

- **work**
  This is the work directory of the Diagnostics Agent.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Required Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/usr/sap/&lt;SAPSID&gt;</code></td>
<td>Primary application server instance or additional application server instance: 2.5 GB</td>
</tr>
</tbody>
</table>

Local Directories (Diagnostics Agent)

The directory `/usr/sap/<SAPSID>` contains files for the operation of a local Diagnostics Agent instance.

This directory is physically located on each host in the SAP system and contains the following subdirectories:

- **exe**
  Contains the following global scripts:
  - `smdstart.sh`
    This script is used to start one or more Diagnostics Agent(s) available in the system landscape.
  - `smdstop.sh`
    This script is used to stop one or more Diagnostics Agent(s) available in the system landscape.
  - `smdadmin.sh`
    This script is used to manage one or more Diagnostics Agent(s) available in the system landscape.

- **<INSTANCE>**
  The directory of the Diagnostics Agent is called `DIA<Instance_Number>`

This directory contains the Instance-specific data of the Diagnostics Agent.

Contains the following subdirectories:

- **profile**
  Contains the `smd.properties` file

- **sapinst**
  Contains log files of the installation

- **script**
  Contains the following local scripts:
  - `smdstart.sh`
    This script is used to start the local Diagnostics Agent.
  - `smdstop.sh`
    This script is used to stop the local Diagnostics Agent.
  - `smdadmin.sh`
    This script is used to manage the local Diagnostics Agent.

- **SMDAgent**
  Contains the Diagnostics Agent software and `properties` files.

- **work**
  This is the work directory of the Diagnostics Agent.
### 3.7 Setting Up File Systems and Raw Devices

**SYS**

- **profile**
  
  Contains the profiles of the Diagnostics Agent instance

<table>
<thead>
<tr>
<th>Directory</th>
<th>Required Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/sap/&lt;SMDSID&gt;/J&lt;instance_number&gt;</td>
<td>500 MB</td>
</tr>
<tr>
<td>/usr/sap/&lt;SMDSID&gt;/SYS/profile</td>
<td></td>
</tr>
<tr>
<td>/usr/sap/&lt;SMDSID&gt;/exe</td>
<td></td>
</tr>
</tbody>
</table>

#### 3.7.2 SAP MaxDB Directories

These are the directories for the SAP MaxDB database:

**SAP MaxDB Directories**

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Description</th>
<th>Space Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>/sapdb/&lt;DBSID&gt;/sapdata</td>
<td>SAP MaxDB data</td>
<td>See the table <em>Hardware Requirements in Requirements for the Database Instance</em> [page 51].</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Note] If the database data is installed on raw devices, you do <strong>not</strong> need to set up /&lt;sapdata&gt;.</td>
</tr>
<tr>
<td>/sapdb/&lt;DBSID&gt;/saplog</td>
<td>SAP MaxDB redologs</td>
<td>See the table <em>Hardware Requirements in Requirements for the Database Instance</em> [page 51].</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Note] If the database data is installed on raw devices, you do <strong>not</strong> need to set up /&lt;sapdblog&gt;.</td>
</tr>
<tr>
<td>/sapdb</td>
<td>SAP MaxDB software</td>
<td>See the table <em>Hardware Requirements in Requirements for the Database Instance</em> [page 51].</td>
</tr>
</tbody>
</table>

#### 3.7.3 Host Agent Directories

For the host agent, the following directories are required:
3.7 Setting Up File Systems and Raw Devices

<table>
<thead>
<tr>
<th>Directories</th>
<th>Description</th>
<th>Required Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/sap/hostctrl</td>
<td>Contains the following directories:</td>
<td>70 MB</td>
</tr>
<tr>
<td></td>
<td>- exe</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Contains the profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>host_profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- work</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Working directory of the host agent</td>
<td></td>
</tr>
</tbody>
</table>

Only valid for: HA (UNIX)

3.7.4 Setting Up File Systems for a High-Availability System

When you prepare a high-availability (HA) installation with switchover software, you need to set up your file systems as described here. For more information, consult your HA partner.

Prerequisites

You have already installed the hardware – that is, hosts, disks, and network – and decided how to distribute the database, SAP instances, and (if required) Network File System (NFS) server over the cluster nodes (that is, over the host machines). For more information, see Planning the Switchover Cluster [page 33].

Procedure

1. Create the file systems or raw partitions for the central services instance on shared disks. For more information, see Setting Up File Systems and Raw Devices [page 66].

Note

The directories /sapmnt/<SAPSID> and /usr/sap/trans have to be mounted from a Network File System (NFS). However, /usr/sap/<SAPSID>/<INSTTYPE><NR>, which should be part of a cluster, has to be a directory of the application server instance that is always mounted on the cluster node currently running the instance (not with NFS).

Therefore, if the host running the primary application server instance is not the NFS server host, you might have to mount the file systems for /sapmnt/<SAPSID> and /usr/sap/trans on different physical disks from the file system for /usr/sap/<SAPSID>/<INSTTYPE><NR>.

2. Use the following approach for the file system for the /usr/sap/<SAPSID> directory:

   The /usr/sap/<SAPSID> directory contains at least two subdirectories:
   - SYS, which contains links to the central directory /sapmnt/<SAPSID>
   - <INSTTYPE><NR> – where the name is defined by the type of services and the application server number, for example SCS<NR> – which contains data for the local Java central services instance.
Only the latter directory needs to be migrated with the application server instance during the switchover. Since the SYS subdirectory contains only links that do not require any space, you can create it locally on each cluster node. Other local instances can also reside locally, such as an Enqueue Replication Server instance in /usr/sap/<SAPSID>/ERS<NR>, which should not be affected by a switchover. Therefore, instead of /usr/sap/<SAPSID>, create a file system for /usr/sap/<SAPSID>/<INSTTYPE><NR> with the usual <> substitutions. The instance-specific directory name for the central services instance is normally SCS<NR>. Migrating only this directory avoids mount conflicts when switching over to a node on which another AS instance is already running. The SCS<NR> directory can join the /usr/sap/<SAPSID> tree instead of mounting on top of it.

Note
This approach becomes increasingly important when you want to cluster the central services instances with other local instances running on the cluster hosts outside the control of the switchover software. This applies to the Enqueue Replication Server (ERS) and additional ABAP or Java application server instances. The result is a more efficient use of resources. You must use this approach for integrated installations of the application server with ABAP and Java stacks.

3. You assign the local file systems to mount points.
4. You assign the shared file systems to mount points in appropriate failover groups.

Example
The graphic below shows an example of the file systems and disks in an HA setup
Note that this is only an example. For more information on a setup that meets your needs, consult
your HA partner.

**Figure 14:**

The diagram illustrates the setup of local and shared disks for nodes A and B, with arrows indicating the flow of data and the failure scenarios for node B.

---

3.7.5 Configuring Network File System for a High-Availability System

If required, you configure Network File System (NFS), which is a system-wide Single Point-of-Failure (SPOF), for a high-availability (HA) installation with switchover software. For more information, consult your HA partner.

We regard NFS as an extension to the operating system. The switchover product protects NFS and makes it transparently available to the SAP system in switchover situations.

You need to decide:

- How to protect NFS
- Which switchover cluster nodes NFS is to run on

The NFS configuration might depend on your database system. The directories need to be available for the SAP system before and after a switchover.
**Procedure**

1. Check the NFS directories, several of which need to be shared between all instances of a system. These directories are:
   - `/sapmnt/<SID>/profile`
     - Contains the different profiles to simplify maintenance
   - `/sapmnt/<SID>/global`
     - Contains log files of batch jobs and central SysLog
   - `/usr/sap/trans`
     - Contains data and log files for objects transported between different SAP systems (for example, development – integration). This transport directory ought to be accessible by at least one AS instance of each system, but preferably by all.
   - `/sapmnt/<SID>/exe`
     - Contains the kernel executables. These executables ought to be accessible on all AS instances locally without having to use NFS. The best solution is to store them locally on all AS instance hosts.

2. Since you can protect NFS by a switchover product, it makes sense to install it on a cluster node. The requirements of your database system might dictate how NFS has to be set up. If required, you can configure the NFS server on the cluster node of the clustered application server instance or the DB.

   In both cases the NFS clients use the virtual IP address to mount NFS. If the second node is used as an additional SAP instance during normal operation (for example, as an additional application server instance), it also needs to mount the directories listed above from the primary node. When exporting the directories with their original names, you might encounter the problem of a “busy NFS mount” on the standby node. You can use the following workaround to solve this problem:

   a) On the primary server, mount the disks containing the directories:
      ```
      /export/usr/sap/trans
      /export/sapmnt/<SID>
      ```
   
   b) The primary server creates soft links to the directories with the original SAP names:
      ```
      /usr/sap/trans -> /export/usr/sap/trans
      /sapmnt/<SID> -> /export/sapmnt/<SID>
      ```
      Alternatively the primary server can also mount the directories:
      ```
      /export/usr/sap/trans -> /usr/sap/trans
      /export/sapmnt/SID -> /sapmnt/<SID>
      ```
   
   c) The primary server exports:
      ```
      /export/usr/sap/trans
      /export/sapmnt/<SID>
      ```
   
   d) The standby NFS mounts:
      ```
      from virt.IP:/export/usr/sap/trans to /usr/sap/trans
      from virt.IP:/export/sapmnt/<SID> to /sapmnt/<SID>
      ```
If the primary node goes down and a switchover occurs, the following happens:

- These directories on the standby node become busy:
  
  ```
  /usr/sap/trans
  /sapmnt/<SID>
  ```

- The standby node mounts disks to:
  
  ```
  /export/usr/sap/trans
  /export/sapmnt/<SID>
  ```

- The standby node configures the virtual IP address **virt.IP**

- The standby node exports:
  
  ```
  /export/usr/sap/trans
  /export/sapmnt/<SID>
  ```

- These directories on the standby node are accessible again:
  
  ```
  /usr/sap/trans
  /sapmnt/<SID>
  ```

End of: HA (UNIX)

### 3.7.6 Setting Up Standard File Systems and Raw Devices for Linux

This section describes how to set up standard files systems for Linux.

**Note**

We do not recommend you to install an SAP system using raw devices. For more information, see SAP Note [40827](#).

If you still want to use raw devices, contact Linux support for information about how to set up raw devices on Linux.

**Prerequisites**

The following table shows the variables and their corresponding values.

**Variables in Standard File Systems**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;diskname&gt;</code></td>
<td>Full path of disk, for example /dev/sda</td>
</tr>
<tr>
<td><code>&lt;mountpointname&gt;</code></td>
<td>Full path of a mount point, for example, /sapdb/&lt;SAPSID&gt;/sapdata1</td>
</tr>
</tbody>
</table>

**Procedure**

1. Create an empty file system.
3.8 Exporting and Mounting the Global Transport Directory

Example
Example for ext2 file system:

```
mke2fs -b 4096 /dev/<device>
```

2. Create a mount point:

```
mkdir <mountpointname>
```

3. Add a line to /etc/fstab.

Example
Example for the ext2 file system:

```
/dev/<device> <mountpointname> ext2 defaults 1 2
```

4. Mount the file system:

```
mount <mountpointname>
```

3.8 Exporting and Mounting the Global Transport Directory

In your SAP system landscape, a global transport directory for all SAP systems is required. During the installation, you can select the check box SAP System will be under NWDI control on the screen NWDI Landscape. Then SAPinst copies all SCAs belonging to the software units that you installed to the global transport directory.

For more information, see the SAP Library [page 12]:

Administrator’s Guide ‹ Software Life Cycle Management › Software Logistics › Using the Development and Production Infrastructure ‹

- If the global transport directory already exists, make sure that it is exported on the global transport directory host and mount it on the SAP instance installation host.
- If the global transport directory does not exist, proceed as follows:
  - Create the transport directory (either on the host where the primary application server instance is running or on a file server).
  - Export it on the global transport directory host.
  - If you did not create the transport directory on your SAP instance installation host, mount it there.

Exporting the Transport Directory

1. Log on as user root to the host where the global transport directory /usr/sap/trans resides.
2. Make sure that /usr/sap/trans belongs to the group sapsys and to the user root.
3. If not already done, export the directory using Network File System (NFS).
### Mounting the Transport Directory

**Note**
If the transport directory resides on your local SAP instance installation host, you do not need to mount it.

1. Log on as user `root` to the host of the primary or additional application server instance, where `/usr/sap/trans` is to be mounted.
2. Create the mount point `/usr/sap/trans`.

### More Information

*Exporting Directories via NFS for Linux [page 78]*

### 3.9 Exporting and Mounting Directories via NFS for Linux (Optional)

To export directories via NFS, perform the following steps (the following assumes that the host running the primary application server instance host is the NFS server):

1. Log on as user `root` to the NFS server.
2. Make sure that your host is configured as NFS server as follows:
   - **On Red Hat Linux**, make sure that the output of the command: `chkconfig --list nfs` looks like:
     ```
     nfs 0:off 1:off 2:off 3:on 4:on 5:on 6:off
     ```
   - **On SUSE Linux**, enter the following command:
     ```
     SLES9 and higher:
     yast or yast2
     ```
   You can set up your host as NFS server as follows:
   - **On Red Hat Linux**, enter the following command:
     ```
     RHEL4 and higher:
     system-config-users
     ```
   - **On SUSE Linux**, enter the following command:
     ```
     SLES9 and higher:
     yast or yast2
     ```
3. To export a directory from a local file system, you can proceed as follows:
   - **On Red Hat Linux**, use the following tool:
     ```
     RHEL4 and higher:
     system-config-nfs
     ```
   - **On SUSE Linux**, use the following tool:
3.9 Exporting and Mounting Directories via NFS for Linux (Optional)

- SLES9 and higher:
  `yast2`
- Perform the configuration manually:
  a) Add a line to the local file `/etc/exports`:

```bash
#/etc/exports
<directory> <hostname>(<options>)
```

**Note**
- There must **not** be a blank between `<hostname>` and `<options>`. Otherwise, the directory is exported with default option `(ro)` (read-only) to the host specified by `<hostname>` and with the option specified by `<options>` to all other hosts.
- To export directories on Linux with root permissions, use the option `no_root_squash`. For security reasons, only use this option during installation.

**Example**

To export the directory `/usr/sap/trans` in read-only mode to the NFS client `host.wdf.sap-ag.de`:

```bash
#/etc/exports
/usr/sap/trans host.wdf.sap-ag.de(ro)
```

To export the directory in read-write mode with root permissions:

```bash
#/etc/exports
/usr/sap/trans host.wdf.sap-ag.de(rw,no_root_squash)
```

To export the directory to all NFS clients of the domain using a wildcard (`*`):

```bash
#/etc/exports
/usr/sap/trans *.wdf.sap-ag.de(rw)
```

b) To activate the changes (that is, inform the NFS daemon about the changes performed in `/etc/exports`), enter the following command:

```bash
exportfs -r
```

To get a list of all currently exported directories, enter the following command:

```bash
exportfs -v
```

For further details, consult the man page by entering `man exports`.

4. Log on as user **root** to the host where the file system is to be imported.

5. To mount the file systems, enter the following command:

```
mount <nfs_server>:<file_system> <mount_point>
```

**Example**

```bash
mount <nfs_server>:/usr/sap/trans /usr/sap/trans
```
3.10 Generating the SAP Solution Manager Key

You need to generate the Solution Manager key because the installation tool prompts for it during the installation. Without this key, the installation process cannot continue.
For more information, see SAP Note 805390.

Procedure

1. If SAP Solution Manager is not yet available in your system landscape, proceed as follows:
   a) Order SAP Solution Manager as described in SAP Note 628901.
   b) Install SAP Solution Manager as described in the documentation Installation Guide – SAP Solution Manager <release> on <OS>: <Database> which is available at:
      http://service.sap.com/solutionmanager

2. Generate the SAP Solution Manager key as described in SAP Note 811923.

Result

The SAP Solution Manager system displays the key for which you are prompted during the installation of your SAP system.

3.11 Preparing the Installation DVDs

This section describes how to prepare the installation DVDs, which are available as follows:
- You normally obtain the installation DVDs as part of the installation package.
- You can also download the installation DVDs from SAP Service Marketplace, as described at the end of this section.

1. Identify the required DVDs for your installation [page 15] as listed below.
   Keep them separate from the remaining DVDs as this helps you to avoid mixing up DVDs during the installation.

   Note
   - The media names listed in the following table are abbreviated.
   - You can find the Software Component Archives (SCAs) for the installation of SAP NetWeaver usage types on the NetWeaver Java DVD.
2. Make the required installation media available on each installation host.

If you need information about how to mount DVDs on Linux, see *Mounting a CD / DVD for Linux* [page 128].

**Note**

Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.

For a standard system, you need to make all required installation media available on the single installation host.

Use one of the following methods to make DVDs available:
- **Before** the installation, copy DVDs manually to local hard disks.
- **During** the installation, use the SAPinst Media Browser dialog and copy the entire DVDs to the path you entered in the *Copy To* column.

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central services instance (SCS)</td>
<td>▪ Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>▪ NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>▪ Kernel DVD</td>
</tr>
<tr>
<td>Database instance</td>
<td>▪ Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>▪ Kernel DVD</td>
</tr>
<tr>
<td></td>
<td>▪ RDBMS DVD</td>
</tr>
<tr>
<td></td>
<td>▪ Export DVD</td>
</tr>
<tr>
<td>HA only:</td>
<td>▪ Installation Master DVD</td>
</tr>
<tr>
<td>Enqueue Replication Server</td>
<td>▪ Kernel DVD</td>
</tr>
<tr>
<td>Primary application server instance</td>
<td>▪ Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>▪ NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>▪ Kernel DVD</td>
</tr>
<tr>
<td></td>
<td>▪ RDBMS DVD</td>
</tr>
<tr>
<td>Additional application server instance</td>
<td>▪ Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>▪ NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>▪ Kernel DVD</td>
</tr>
<tr>
<td></td>
<td>▪ RDBMS Client DVD</td>
</tr>
<tr>
<td>Host Agent (Standalone)</td>
<td>▪ Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>▪ Kernel DVD</td>
</tr>
</tbody>
</table>
Caution

- Mount the DVDs locally. We do not recommend you to use Network File System (NFS), because reading from DVDs mounted with NFS might fail.
- If you copy the DVDs to disk, make sure that the paths to the destination location of the copied DVDs do not contain any blanks.
- If you perform a local installation and there is only one DVD drive available on your installation host, you must copy at least the Installation Master DVD to the local file system.

Downloading Installation DVDs from SAP Service Marketplace (Optional)

You normally obtain the installation DVDs as part of the installation package from SAP. However, you can also download installation DVDs from SAP Service Marketplace at:


Note

If you download installation DVDs, note that the DVDs might be split into several files. In this case, you have to reassemble the required files after the download.

Caution

To extract the downloaded SAR files make sure that you use the latest SAPCAR version, which you can find on SAP Service Marketplace at http://service.sap.com/swdc. You need at least SAPCAR 700 or SAPCAR 640 with patch level 4 or higher because older versions of SAPCAR can no longer unpack current SAR files. For more information, see SAP Note 212876.

1. Create a download directory on the host where you want to run SAPinst.
2. Identify all download objects that belong to one installation DVD according to one or both of the following:
   - Material number
     All download objects that are part of an installation DVD have the same material number and an individual sequence number:
     \(<material\_number>_<sequence\_number>\)

     **Example**
     
     51031387_1
     51031387_2
     ...

   - Title
     All objects that are part of an installation DVD have the same title, such as
     \(<solution><DVD\_name><OS>\) or \(<database>RDBMS<OS>\) for RDBMS DVDs.
3. Download the objects to the download directory.
4. Extract the individual download objects using SAPCAR, starting with the lowest sequence number – for example 51031387_1, then 51031387_2, and so on.

During the download SAPCAR sets up the structure of the installation DVD.

**Note**

SAPCAR asks if you want to replace existing files, for example LABELIDX.ASC. Always accept with **Yes**.
This page is intentionally left blank.
4 Installation

Installation Steps for a Standard System
1. You run SAPinst [page 89] to install the SAP system.
2. You continue with Post-Installation [page 103].

Installation Steps for a Distributed System
1. If you want to share the transport directory trans from another system, you have to mount [page 77] it from this system. Otherwise we recommend that you share the trans directory that is created during the installation of the primary application server instance.
2. On the SAP global host, you do the following:
   a) If you want to share the transport directory trans from another system, you have to mount [page 77] it from this system. Otherwise we recommend that you share the trans directory that is created during the installation of the primary application server instance.
   b) You export global directories [page 88] in <sapmnt>/<SAPSID> to the database and primary application server instance host.
3. On the database instance host, you do the following:
   a) You mount the global directories [page 88] in <sapmnt>/<SAPSID> that you exported from the SAP global host and – optionally – the trans directory that you exported [page 77] from the SAP transport host.
   b) You run SAPinst [page 89] to install the database instance.
4. On the primary application server instance host, you do the following:
   a) You mount the global directories [page 88] in <sapmnt>/<SAPSID> that you exported from the SAP global host.
   b) You run SAPinst [page 89] to install the primary application server instance.
   c) If you want to use the shared transport directory trans from another system, you also mount [page 77] this directory.
5. If required, you can now install one to n additional application server instance(s) [page 18].
6. You continue with Post-Installation [page 103].

Installation Steps for a High-Availability System
1. If you want to share the transport directory trans from another system, you have to mount [page 77] it from this system. Otherwise we recommend that you share the trans directory that is created during the installation of the primary application server instance (see below).
2. You set up the switchover cluster infrastructure as follows:
   a) You run SAPinst [page 89] to install the central services instance (SCS) using the virtual host name [page 89] on the primary cluster node, host A.
**b)** You prepare the standby cluster node, **host B**, making sure that it meets the *hardware and software requirements* [page 45] and it has all the necessary *file systems* [page 72], mount points, and (if required) Network File System (NFS).

c) You set up the user environment on the standby node, host B.

For more information, see *Creating Operating System Users and Groups* [page 61]. You make sure that you use the same *user and group IDs* [page 61] as on the primary node. You create the home directories of users and copy all files from the home directory of the primary node.

d) You configure the switchover software and test that switchover functions correctly to **all** standby nodes in the cluster.

e) You perform the switchover to a node where you want to install the enqueue replication server (ERS).

f) You **run** SAPInst [page 89] to install the enqueue replication server (ERS).

g) You repeat the previous two steps for **all** nodes in the cluster.

3. You **export global directories** [page 88] in `<sapmnt>/<SAPSID>` to the database host and to the primary application server instance host.

4. On the **database instance host**, you do the following:

   a) You make available the global directories in `<sapmnt>/<SAPSID>` from the switchover cluster infrastructure and – optionally – from the SAP transport host.

   b) You **run** SAPInst [page 89] to install the database instance on the **database instance host**.

5. On the **primary application server instance host**, you do the following:

   **Note**

   In a high-availability installation, the primary application server instance does **not** need to be part of the cluster because it is no longer a single point of failure (SPOF). The SPOF is now in the central services instance (SCS), which is protected by the cluster.

   a) You **mount the global directories** [page 88] in `<sapmnt>/<SAPSID>` that you exported from the switchover cluster infrastructure.

   b) You **run** SAPInst [page 89] to install the primary application server instance.

   c) If you want to use the shared transport directory `trans` from another system, you also **mount** [page 77] this directory (see above).

6. We recommend you to install additional application server (AS) instances with SAPInst to create redundancy.

   Since the AS instances are not a SPOF, you do **not** need to include these instances in the cluster.

7. You continue with *Post-Installation* [page 103].
**Installation Steps for an Additional Application Server Instance**

Installation Steps for Additional Application Server Instance(s) for a Standard System

1. On the **main host** on which your SAP system runs, you export global directories in `<sapmnt>/SAPSID` to the database and primary application server instance host.

2. On every **additional application server instance host**, you do the following:
   a) You **mount the global directories** [page 88] in `<sapmnt>/SAPSID` that you exported from the SAP global host.
   b) You **run SAPinst** [page 89] to install the additional application server instance.

3. You continue with **Post-Installation** [page 103].

Installation Steps for an Application Server Instance for a Distributed System

1. If you want to share the transport directory `trans` from another system, you have to **mount** [page 77] it from this system. Otherwise we recommend that you share the `trans` directory that is created during the installation of the primary application server instance.

2. On the **SAP global host**, you export global directories in `<sapmnt>/SAPSID` to the database and primary application server instance host.

3. On every **additional application server instance host**, you do the following:
   a) You **mount the global directories** [page 88] in `<sapmnt>/SAPSID` that you exported from the SAP global host.
   b) You **run SAPinst** [page 89] to install the additional application server instance.
   c) If you want to use the shared transport directory `trans` from another system, also **mount** [page 77] this directory.

4. You continue with **Post-Installation** [page 103].

Installation Steps for an Additional Application Server Instance for a High-Availability System

1. If you want to share the transport directory `trans` from another system, you have to **mount** [page 77] it from this system. Otherwise we recommend that you share the `trans` directory that is created during the installation of the primary application server instance.

2. On the **primary node, host A**, of the switchover cluster **infrastructure**, you export global directories in `<sapmnt>/SAPSID` to every additional application server instance host.

3. On every **additional application server instance host**, you do the following:
   a) You **mount the global directories** [page 88] in `<sapmnt>/SAPSID` that you exported from the SAP global host.
   b) You **run SAPinst** [page 89] to install the additional application server instance.
   c) If you want to use the shared transport directory `trans` from another system, you also **mount** [page 77] this directory.

4. You continue with **Post-Installation** [page 103].
Installation Steps for Additional Components and Tools for SAP NetWeaver CE (Optional)

- You install additional components [page 98] for SAP NetWeaver Composition Environment, such as
  - Composition Tools
  - Adobe Document Services
  - Composite Voice
  - IDE Update Site
- You install SAP Memory Analyzer [page 100] for SAP NetWeaver Composition Environment.

Installation Steps for a Standalone Host Agent

1. You run SAPInst [page 89] to install the host agent.
2. You continue with Post-Installation [page 103].

4.1 Exporting and Mounting Global Directories

If you install a database or an additional application server instance on a host other than the SAP Global host, you must mount global directories from the SAP Global host.

Prerequisites

If you want to install the executables locally instead of sharing them, do not mount the exe directory with Network File System (NFS). Instead, create `<sapmnt>/<SAPSID>/exe` as a local directory (not a link) with a minimum of 1.5 GB free space.

Procedure

1. Log on to the SAP Global host as user root and export the following directories with root access to the host where you want to install the new instance:
   `<sapmnt>/<SAPSID>/exe`
   `<sapmnt>/<SAPSID>/profile`
   `<sapmnt>/<SAPSID>/global`
   For more information, see Exporting Directories via NFS for Linux [page 78].
   Make sure that the user root of the host where you want to install the new instance can access the exported directories.
2. Log on to the host of the new instance that you want to install as user root.
3. Create the following mount points and mount them from the SAP Global host:
   `<sapmnt>/<SAPSID>/exe`
   `<sapmnt>/<SAPSID>/profile`
   `<sapmnt>/<SAPSID>/global`
4.2 Specifying the Virtual Host Name

If you want to use a virtual host name, you can set the environment variable SAPINST_USE_HOSTNAME to specify the virtual host name before you start SAPinst. You can also specify the virtual host name by starting SAPinst [page 89] with an equivalent parameter in the command line.

Procedure

Set SAPINST_USE_HOSTNAME to the virtual host name of the machine on which you are installing an SAP instance as follows:

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bourne shell (sh)</td>
<td>SAPINST_USE_HOSTNAME=&lt;directory&gt;</td>
</tr>
<tr>
<td></td>
<td>export SAPINST_USE_HOSTNAME</td>
</tr>
<tr>
<td>C shell (csh)</td>
<td>setenv SAPINST_USE_HOSTNAME &lt;directory&gt;</td>
</tr>
<tr>
<td>Korn shell (ksh)</td>
<td>export SAPINST_USE_HOSTNAME=&lt;directory&gt;</td>
</tr>
</tbody>
</table>

More Information

For more information about the use of virtual TCP/IP host names, see SAP Note 962955.

4.3 Running SAPinst

This procedure tells you how to install an SAP system with SAPinst. SAPinst includes a SAPinst GUI and a GUI server, which both use Java.

If you need to see the installation on a remote display, we recommend you perform a remote installation with SAPinst [external document], where SAPinst GUI is running on a separate host from SAPinst and the GUI server. Alternatively you can use an X Server for Microsoft Windows or other remote desktop tools like vncviewer or nxserver/nxclient offered by various vendors (or OpenSource) for the Remote Access of SAPinst GUI on Windows Workstations. We recommend you use the Hummingbird Exceed X Server which we use ourselves to validate installations with SAPinst.

Note the following information about SAPinst:

- SAPinst normally creates the installation directory sapinst_instdir directly below the temporary directory. SAPinst finds the temporary directory by checking the value of the TEMP, TMP, or TMPDIR environment variable. If no value is set for these variables, SAPinst uses /tmp as default installation directory.
- If you want to use an alternative installation directory, set the environment variable TEMP, TMP, or TMPDIR to the required directory before you start SAPinst.
We recommend that you keep all installation directories until the system is completely and correctly installed.

- SAPInst creates a subdirectory for each installation option called `<sapinst_instdir>/<installation_option_directory>`.
- The SAPInst Self-Extractor extracts the SAPInst executables to the temporary directory. These executables are deleted again after SAPInst has stopped running. Directories called `sapinst_exe.xxxxx.xxxx` sometimes remain in the temporary directory. You can safely delete them.
- The temporary directory also contains the SAPInst Self-Extractor log file `dev_selfex.out`, which might be useful if an error occurs.

Caution

If SAPInst cannot find a temporary directory, the installation terminates with the error FCO-00058.

- During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPInst, GUI server, SAPInst GUI and HTTP server. SAPInst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPInst GUI. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service.
- In this case, you must execute `sapinst` using the following parameters:
  
  ```
  SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>
  GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
  GUISERVER_HTTP_PORT=<free_port_number_http_server>
  ```

- To get a list of all available SAPInst properties, start SAPInst as described above with the option `-p`:
  ```
  ./sapinst -p
  ```
- If required, you can terminate SAPInst and the SAPInst Self-Extractor by pressing `Ctrl` + `C`.

Using SAPInst GUI

The following table shows the most important functions that are available in SAPInst GUI:

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>F1</td>
<td>Displays detailed information about each input parameter</td>
</tr>
<tr>
<td>Menu option</td>
<td>➤File ➤Exit</td>
<td>Stops the SAPInst GUI, but SAPInst and the GUI server continue running</td>
</tr>
</tbody>
</table>
### Input Type | Label | Description
--- | --- | ---
Menu option | SAPinst Log Browser 4 | Displays the Log Viewer dialog. This dialog enables you to access the following log files directly:
- Installation log (sapinst.dev.log)
- Log files from the SAPinst GUI server

Menu option | SAPinst Cancel 4 | Cancels the installation with the following options:
- **Stop**
  - Stops the installation (SAPinst GUI, SAPinst and the GUI server) without further changing the installation files.
  - You can restart and continue the installation later from this point.
- **Continue**
  -Continues the installation

Message button | Retry | Performs the installation step again (if an error has occurred)

Message button | Stop | Stops the installation without further changing the installation files.
You can continue the installation later from this point.

Message button | Continue | Continues with the option you have chosen before

---

### Prerequisites

- Make sure that your operating system does not delete the contents of the temporary directory `/tmp` or the contents of the directories to which the variables `TEMP`, `TMP`, or `TMPDIR` point, for example by using a `crontab` entry.

  Make sure that the temporary directory has the permissions 777.

- Make sure that you have at least 300 MB of free space in the installation directory for each installation option. In addition, you need 300 MB free space for the SAPinst executables. If you cannot provide 300 MB free space in the temporary directory, you can set one of the environment variables `TEMP`, `TMP`, or `TMPDIR` to another directory with 300 MB free space for the SAPinst executables.

  You can set values for the `TEMP`, `TMP`, or `TMPDIR` environment variable as follows:

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
</table>
| Bourne shell (sh)   | `TEMP=<directory>
    export TEMP`                                    |
| C shell (csh)       | `setenv TEMP <directory>`                          |
| Korn shell (ksh)    | `export TEMP=<directory>`                          |
Make sure that your DISPLAY environment variable is set to `<host_name>:0.0`, where `<host_name>` is the host on which you want to display the SAPinst GUI. You can set values for the DISPLAY environment variables as follows:

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bourne shell (sh)</td>
<td>DISPLAY=&lt;host_name&gt;:0.0</td>
</tr>
<tr>
<td></td>
<td>export DISPLAY</td>
</tr>
<tr>
<td>C shell (csh)</td>
<td>setenv DISPLAY &lt;host_name&gt;:0.0</td>
</tr>
<tr>
<td>Korn shell (ksh)</td>
<td>export DISPLAY=&lt;host_name&gt;:0.0</td>
</tr>
</tbody>
</table>

Make sure that you have checked the following values for user root:

- In csh execute `limit`

<table>
<thead>
<tr>
<th>Output</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>cputime</td>
<td>unlimited</td>
</tr>
<tr>
<td>filesize</td>
<td>unlimited</td>
</tr>
<tr>
<td>filesize</td>
<td>2097148 KB</td>
</tr>
<tr>
<td>stacksize</td>
<td>8192 KB</td>
</tr>
<tr>
<td>coredumpsize</td>
<td>unlimited</td>
</tr>
<tr>
<td>descriptors</td>
<td>8192</td>
</tr>
<tr>
<td>memorysize</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

- In sh or ksh execute `ulimit -a`

<table>
<thead>
<tr>
<th>Output</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>time(seconds)</td>
<td>unlimited</td>
</tr>
<tr>
<td>file(blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>data(kbytes)</td>
<td>2097148</td>
</tr>
<tr>
<td>stack(kbytes)</td>
<td>8192</td>
</tr>
<tr>
<td>coredump(blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>nofiles(descriptors)</td>
<td>8192</td>
</tr>
<tr>
<td>memory(KBytes)</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

If your parameter settings differ from the settings above, change these values accordingly.
Example

If you have to change the value for descriptors to 8192, proceed as follows:

- In csh execute:
  
  \[
  \text{limit descriptors 8192}
  \]

- In sh or ksh execute:
  
  \[
  \text{ulimit -n 8192}
  \]

Make sure that you have defined the most important SAP system parameters as described in Basic SAP System Parameters [page 38] before you start the installation.

Check that your installation host(s) meets the requirements for the installation option(s) that you want to install. For more information, see Running the Prerequisite Checker [page 47].

If you are installing a second or subsequent SAP system in an existing database, make sure that the database is up and running before starting the installation. For more information, see Installation of Multiple Components in One Database [page 31].

Procedure

1. Log on to your host as user root.

   Caution
   
   Make sure that the root user has not set any environment variables for a different SAP system or database.

2. If you want to install a primary application server instance, a central services instance, a database instance, or an additional application server instance, mount the Installation Master DVD. Mount the DVDs locally. We do not recommend that you use Network File System (NFS), because reading from DVDs mounted with NFS might fail.

   For more information about mounting DVDs, see Mounting a CD / DVD for Linux [page 128].

3. Start SAPinst from the Installation Master DVD by entering the following commands:

   \[
   \text{cd <mountpoint_of_Installation Master DVD>/DATA_UNITS/IM_<OS>_<DB>}
   \]
   
   \[
   \text{./sapinst}
   \]

Example

For example, if the mountpoint of the Installation Master DVD is sapcd2, the operating system is LINUX_X86_64 and the database is Oracle, the commands are as follows:

\[
\text{cd /sapcd2/DATA_UNITS/IM_LINUX_X86_64_ORA}
\]

\[
\text{./sapinst}
\]
If you want to use a virtual host name and you have not already set the environment variable `SAPINST_USE_HOSTNAME` [page 89] to specify the virtual host name, start SAPinst as follows:

```
./sapinst SAPINST_USE_HOSTNAME=<virtual host name>
```

4. In the **Welcome** screen, choose the required SAPinst installation option from the tree structure. For more information, see **SAPinst Installation Options** [page 95].

5. Follow the instructions in the SAPinst input dialogs and enter the required parameters.

```
Note
```

To find more information on each parameter during the input phase of the installation, position the cursor on the required parameter and press **F1**.

After you have entered all requested input parameters, SAPinst displays the **Parameter Summary** screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose **Start**.

SAPinst starts the installation and displays the progress of the installation. When the installation has successfully completed, SAPinst shows the dialog **Execution of <option_name> has been completed successfully**.

7. If required, delete directories with the name `sapinst.exe.xxxxx.xxxx` after SAPinst has finished. Sometimes these remain in the temporary directory.
**4.4 SAPinst Installation Options**

This section provides information about the following in SAPinst:

- **Installation Options**
- **Software Life-Cycle Options**

**Note**

Choose the required installation options from the tree structure **exactly** in the order they appear for each system variant.

- If you want to use global accounts, which are configured on separate hosts, you must run the installation option **Operating System Users and Groups before** you start the installation of the SAP system (see table **Software Life-Cycle Options** below).
- If required, install an additional application server instance for a standard system (all instances on one host) or distributed system by choosing **<SAP System> Software Life-Cycle Options Additional Application Server Instance**.
- If required, install additional CE components by choosing **<SAP System> Software Life-Cycle Options Additional CE Components**.
- If required, install SAP Memory Analyzer by choosing **<SAP System> Software Life-Cycle Options SAP Memory Analyzer**.

**More Information**

- **Interrupted Installation with SAPinst** [external document]
- **Entries in the Services File Created by SAPinst** [external document]
- **Troubleshooting with SAPinst** [external document]
4.4 SAPinst Installation Options

Installation Options
You choose SAP Systems with <your database> to install a SAP system with usage types or software units. You can install the following system variants:

- **Standard System**

Installation Options for a Standard System

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
</table>
| Standard System     | Installs a complete SAP system including the following instances on one host: 
                      ● Central services instance (SCS) 
                      ● Database instance 
                      ● Primary application server instance 
                      You can install a standard system in the following modes: 
                      ● Typical Mode 
                        If you choose Typical, the installation automatically uses default settings. You only have to respond to a small selection of prompts. However, you can change any of the default settings on the parameter summary screen. 
                      ● Custom Mode 
                        If you choose Custom, the installation prompts you for all parameters. At the end, you can change any parameter on the parameter summary screen. |

**Note**
You require at least usage type AS Java or AS ABAP. You can choose the usage types or software units on the next screen.

- **Distributed System**

Installation Options for a Distributed System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS) and prepares the SAP global host Mandatory step in installing a distributed SAP system with usage types or software units based on AS Java</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance Mandatory step in installing a distributed SAP system You must have finished the Central Services Instance (SCS) installation before you can choose this installation option.</td>
</tr>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional software units Mandatory step in installing a distributed SAP system on several hosts You must have finished the database instance installation.</td>
</tr>
</tbody>
</table>

Only valid for: HA (MSCS):HA (UNIX):HA (z/OS)

- **High-Availability System**
4.4 SAPinst Installation Options

### Installation Options for a High Availability System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS)</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance</td>
</tr>
<tr>
<td>Enqueue Replication Server Instance</td>
<td>Installs an enqueue replication server, which contains a replica of the lock table (replication server)</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Make sure that you have configured the SCS instance for the switchover cluster before starting this installation option.</td>
</tr>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional usage types or software units</td>
</tr>
<tr>
<td>Additional Application Server Instance</td>
<td>Installs an additional application server instance</td>
</tr>
</tbody>
</table>

| End of: | HA (MSCS); HA (UNIX); HA (z/OS) |

### Software Life-Cycle Options

You use the options located in this folder to perform the following tasks or to install the following components:

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Additional Preparations</strong></td>
<td>■ <strong>Host Agent</strong>&lt;br&gt;Choose [Additional Preparations] Host Agent to install the host agent with the profiles SAPSystem=99 and SAPSystemName=SAP.&lt;br&gt;The host agent contains all of the required elements for centrally monitoring any host.&lt;br&gt;Normally you do not need to install a standalone host agent, because it is automatically installed during the installation of all SAP NetWeaver components, except TREX.&lt;br&gt;You only need to install a standalone host agent when:&lt;br&gt;● You want to centrally monitor a host that does not have an SAP component.&lt;br&gt;● You want to perform an upgrade to SAP NetWeaver.&lt;br&gt;For more information, see Standalone Host Agent [page 21].&lt;br&gt;■ <strong>Operating system users and groups</strong>&lt;br&gt;Lets you use global accounts that are configured on a separate host.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>Perform this SAPinst option <strong>before</strong> you start the installation of your SAP system.</td>
</tr>
<tr>
<td><strong>Prerequisites check</strong></td>
<td></td>
</tr>
</tbody>
</table>
## 4.5 Installing Additional Components (Optional)

You can install the following additional components:

- Composition Tools
- Adobe Document Services (if available for your platform)
- Composite Voice
- IDE Update Site

### Prerequisites

You need to fulfill the same hardware and software requirements as for your already installed production system plus an additional 2 GB RAM.

The Composition Tools and Composite Voice component make use of the Visual Composer. Visual Composer is a Web browser based tool to model user interfaces. To run Visual Composer, the following programs must be installed on the client computer from which you access Visual Composer:
4.5 Installing Additional Components (Optional)

- Microsoft Internet Explorer 6.0 SP1 or higher
- Adobe SVG Viewer 3.0
- Microsoft XML Parser 4.0 or higher

**Note**

- Before installing additional components, you need to stop all application servers manually.
- Before installing additional components and in the case that you made changes to the default template settings, see SAP Note 953763.

**Procedure**

**Note**

When installing from a network share make sure that **everyone** has read access to this share. The installation routine creates users such as <sid>adm (for example, ce1adm). During the installation SAPInst does a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPInst [page 89].
3. In the Welcome screen, choose \SAP NetWeaver CE Productive System \ Software Life-Cycle Options \ Additional CE Components \ Install Additional Components \.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

**Note**

If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.
After the installation, you can access the offline documentation by choosing \Start \ All Programs \ SAP NetWeaver Composition Environment \ Start \.<SAPSID> \.

5. Follow the screens and enter the required parameters.

**Note**

For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press **F1**.
After you have entered all requested input parameters, SAPInst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPInst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPInst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPInst shows the dialog Execution of <Option_Name> has been completed successfully.

Note

After installing additional components, you need to perform CE-specific post-installation activities [page 119] to get the system up & running.

4.6 Installing SAP Memory Analyzer (Optional)

SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive. New and innovative analysis techniques support the user with a fast and powerful feature set.

The tool (Eclipse RCP application) was developed to analyze real productive heap dumps, which tend to get enormous in size with hundreds of millions of objects. Performance, low resource consumption and especially the newly developed innovative analysis techniques make it a helpful tool, even to small application heap dumps.

You can install SAP Memory Analyzer as an additional tool.

Procedure

Note

When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, ce1adm). During the installation SAPInst performs a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPInst [page 89].
3. In the Welcome screen, choose SAP NetWeaver CE Productive System ▶ Software Life-Cycle Options ▶ SAP Memory Analyzer ▶ Install SAP Memory Analyzer 4.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.
4.6 Installing SAP Memory Analyzer (Optional)

Note
If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.
After the installation, you can access the offline documentation by choosing Start > All Programs > SAP NetWeaver Composition Environment > <SAPSID>.

5. Follow the screens and enter the required parameters.

Note
For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog Execution of <Option_Name> has been completed successfully.
This page is intentionally left blank.
5 Post-Installation

This section includes the post-installation steps that you have to perform for the:

- Standard, distributed or high-availability system
- Additional application server instance
- Standalone host agent

**Standard, Distributed, or High-Availability System**

**Note**

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. If required, you perform a full installation backup [page 122] immediately after the installation has finished.
2. You check whether you can log on to the SAP system [page 104].

**Note**

In a distributed or high-availability system you check whether your can log on to every instance of the SAP system that you installed.

3. You ensure user security [page 105].
4. You install the SAP license [page 107].
   
   Only valid for: HA (UNIX)

5. You set up the licenses for high availability [page 110].
   
   End of: HA (UNIX)

6. You configure the remote connection to SAP support [page 108].
7. If required, you install MaxDB administration tools [page 111].
8. If required, you install Secure Sockets Layer (SSL) for MaxDB [page 113].
9. You back up the MaxDB database [page 117].
10. You update the database software to the current release [page 117].
11. On the primary application server instance host, you apply the latest kernel and Support Packages [page 109].
12. You check the Java manuals [page 118] for information that is relevant for running your Java system.
14. You perform a full installation backup [page 122].
15. If you want or need to implement the E2E Root Cause Analysis scenario, you have to perform post-installation steps for the Diagnostics Agent [page 124] on your central instance and/or dialog instance(s).
5.1 Logging On to the Application Server

You need to check that you can log on to the application server using the following standard users:

### Java Standalone Users

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>You create this user manually during the installation process.</td>
</tr>
</tbody>
</table>

**Recommendation**

We recommend that you call the user `J2EE_ADM_<SAPSID_Java_System>`.

The maximum length is **12** characters.

### Prerequisites

- The SAP system is up and running.

**Logging On to the Java Application Server**

You access AS Java with a URL using a Web browser from your client machines. To log on to the Java application server, proceed as follows:

1. Start a Web browser and enter the following URL:
   
   `http://<hostname_of_Java_EE_Engine_Server>:5<Instance_Number>00`

**Note**

You must always enter a two-digit number for `<Instance_Number>`. For example, do **not** enter `1` but instead enter `01`. 

---

**Additional Application Server instance**

1. If required, you perform a full installation backup [page 122] immediately after the installation has finished.
2. You check whether you can log on to the additional application server instance [page 104].
3. You perform a full installation backup [page 122].
4. If you want or need to implement the E2E Root Cause Analysis scenario, you have to perform post-installation steps for the Diagnostics Agent [page 124] on your central instance and/or dialog instance(s).

**Standalone Host Agent**

You perform the post-installation steps for the Host Agent [page 117].
Example

If you installed the SAP NetWeaver Application Server Java on host saphost06 and the instance number of your SAP NetWeaver Application Server Java is 04, enter the following URL:

http://saphost06:50400

The start page of the SAP NetWeaver Application Server Java appears in the Web browser.

2. Log on by pressing the icon of any of the provided applications, for example the SAP NetWeaver Administrator.

5.2 Ensuring User Security

You need to ensure the security of the users that SAPinst creates during the installation. For security reasons, you also need to copy the installation directory to a separate, secure location – such as a DVD – and then delete the installation directory.

Recommendation

In all cases, the user ID and password are only encoded when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

For more information, see the SAP Library [page 12]:

Function-Oriented View  Security  Network and Transport Layer Security

Caution

Make sure that you perform this procedure before the newly installed SAP system goes into production.

Prerequisites

If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.

Procedure

For the users listed below, take the precautions described in the relevant SAP security guide, which you can find on SAP Service Marketplace at http://service.sap.com/securityguide:
### Operating System and Database Users

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sqd&lt;dbsid&gt;</td>
<td>SAP MaxDB database administrator (that is, the owner of the database files)</td>
</tr>
<tr>
<td>SAP MaxDB database users</td>
<td>SAP&lt;SAPSID&gt;DB</td>
<td>SAP MaxDB database owner (that is, the owner of the database tables)</td>
</tr>
<tr>
<td></td>
<td>CONTROL</td>
<td>SAP MaxDB database studio operator</td>
</tr>
<tr>
<td></td>
<td>SUPERDBA</td>
<td>SAP MaxDB database system administrator</td>
</tr>
</tbody>
</table>

### Host Agent User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You do not need to change the password of this user after the installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This user is for administration purposes only.</td>
</tr>
</tbody>
</table>

### Note

You can set up Java standalone users with the SAP User Management Engine (UME) in one of the following ways:
- With the users stored in an external ABAP system – see the first table below
- With the users stored in the database – see the second table below

The next two tables show these ways of managing the users.

### SAP System Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the Config Tool. For more information, see Checking the SAP Java Documentation [page 118].</td>
</tr>
</tbody>
</table>

Recommendation

We recommend that you call the user J2EE_ADM_<SAPSID_Java_System>

The maximum length is 12 characters.
5.3 Installing the SAP License

You must install a **permanent** SAP license. When you install your SAP system, a **temporary** license is automatically installed. This temporary license allows you to use the system for **only four weeks** from the date of installation.

⚠️ **Caution**

**Before** the temporary license expires, you must apply for a permanent license key from SAP. We recommend that you apply for a permanent license key as soon as possible after installing your system.
### 5.4 Configuring the Transport Management System

You have to perform some steps to be able to use the Transport Management System.

**Procedure**

1. Perform post-installation steps for the transport organizer:
   a) Call transaction SE06.
   b) Select Standard Installation.
   c) Choose Perform Post-Installation Actions.
2. Call transaction STMS in your SAP Solution Manager system to configure the domain controller in the Transport Management System (TMS).

**Result**

You can now perform Java transports in the TMS of your SAP Solution Manager system.

**More Information**

For more information, see the SAP Library [page 12]:

- Function-Oriented View
- Application Server ABAP
- Administration Tools for AS ABAP
- Change and Transport System

### 5.5 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the EarlyWatch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP. For more information, see SAP Service Marketplace at http://service.sap.com/remoteconnection.
5.6 Applying the Latest Kernel and Support Packages

You have to apply the latest kernel and Support Packages for your SAP system from SAP Service Marketplace.

⚠️ Caution

Before you apply support packages, make sure that you read the release notes for your SAP system. You can find these at http://service.sap.com/releasenotes. The release notes might include information about steps you have to perform after you have applied the support packages.

⚠️ Caution

Make sure that the entry DIR\_CT\_RUN exists in the instance profile. Otherwise you cannot restart the system after patches have been applied.

You can use Java Support Package Manager (JSPM) to apply both the latest ABAP+Java or Java kernel and Java support packages. JSPM is a Java standalone tool that you can use with SAP NetWeaver 7.1. JSPM uses the Software Deployment Manager (SDM) to apply support packages and patches and to deploy software components.

For more information about JSPM and how to use this tool, see the SAP Library [page 12]: [Administrator’s Guide] [Technical Operations for SAP NetWeaver] [General Administration Tasks] [Software Life-Cycle Management] [Software Logistics] [Application Server Java (AS Java)] [Software Logistics] [Software Maintenance] [Java Support Package Manager (JSPM)].

[Administrator’s Guide] [Technical Operations for SAP NetWeaver] [General Administration Tasks] [Software Life-Cycle Management] [Software Logistics] [Application Server Java (AS ABAP)] [Software Logistics] [Software Maintenance] [Support Package Manager (SPAM)].

Procedure

1. Apply the latest kernel.
   We recommend that you replace the installed kernel with the latest kernel from SAP Service Marketplace. In particular, you should replace the installed kernel if:
   - You installed the kernel executables locally on every host.
   - Your primary application server instance host runs on a different operating system than your additional application server instance host.

   For more information about how to download a kernel, see SAP Note 19466.

   To exchange the ABAP+Java kernel, you can use Java Support Package Manager (JSPM).

2. Apply Support Packages.
   a)
   b) Alternatively, you can download Support Packages from:

       http://service.sap.com/patches
c) Apply the Java Support Packages to your SAP system with the help of the Java Support Package Manager (JSPM).

For more information about the availability of Support Packages, see:
http://service.sap.com/ocs-schedules

For more information about how to update your CE system, see the documentation SAP NetWeaver Composition Environment 7.1 — Update Guide SP<xx>, available at

Only valid for: HA (UNIX)

5.7 High Availability: Setting Up Licenses

Every SAP system needs a central license, which is determined by the environment of the message server. Since SAP’s high-availability (HA) solution stipulates two or more cluster nodes (host machines) where the message server is enabled to run, you have to order as many license keys [page 107] as you have cluster nodes.

When we receive confirmation from your vendor that you are implementing a switchover environment, we provide the required license keys for your system, one key for each machine. SAP has implemented a license mechanism for transparent and easy use with switchover solutions and clustered environments. Your customer key is calculated on the basis of local information on the message server host. This is the host machine where the central services instance (SCS) runs. There is no license problem when only the database is switched over.

Prerequisites
The SAP system is up and running.

Procedure

1. Make sure that the SCS instance on the primary host, node A, is running.
2. To find the hardware key of the primary host, run the SAP NetWeaver Administrator (NWA) on any application server instance and choose Configuration Management » Infrastructure Management » Licenses ».
   The hardware key is displayed in the NWA.
3. Perform a switchover of the central services instance (SCS) to another node in the cluster and repeat the previous step.
   Repeat this for all remaining nodes in the cluster.
4. To obtain the two license keys, enter the hardware IDs for the primary and backup hosts at:
   http://service.sap.com/licensekey
5. To import the files containing the two licenses to the primary cluster node, run the NWA on any application server instance and choose:
6. Perform a switchover of the central services instance (SCS) to another node in the cluster and repeat the previous step. Repeat this for all remaining nodes in the cluster.

\textbf{Result}

The license is no longer a problem during switchover. This means you do not need to call \texttt{saplicense} in your switchover scripts.

---

\section*{5.8 Installing or Upgrading Database Studio for SAP MaxDB}

This section describes how to install or upgrade Database Studio for SAP MaxDB and SAP liveCache on Windows front ends. Database Studio is the database administration tool for SAP MaxDB. For more information about Database Studio, see:

\url{https://www.sdn.sap.com/irj/sdn/maxdb} \texttt{\textbullet SAP MaxDB Knowledge Center} \texttt{\textbullet The Complete SAP MaxDB Documentation Set} \texttt{\textbullet Open the SAP MaxDB 7.7 Library} \texttt{\textbullet Tools} \texttt{\textbullet Database Studio}

\textbf{Note}

Database Studio replaces Database Manager and SQL Studio, which were available in previous releases. For more information about how to install Database Studio, see SAP Note 109731.

\section*{Prerequisites}

- You can install Database Studio on Linux or Windows (32-bit or 64-bit) in your network, even if your database runs on a different operating system. You can then remotely administer the database on a different host.
  The instructions below refer to the Windows version.
- Your PC must meet the following minimum operating system requirements:

\begin{center}
\begin{tabular}{|l|l|}
\hline
\textbf{Operating System} & \textbf{Version} \\
\hline
Windows 2000 & Any \\
Windows 2003 & Any \\
\hline
\end{tabular}
\end{center}

- Your PC must meet the following minimum hardware requirements:
  - Pentium II
  - 64 MB RAM
  - 100 MB disk space
You can get the required files from one of the following:
- The MaxDB RDBMS or SAP liveCache DVD
- By downloading from:
  - [http://service.sap.com/patches](http://service.sap.com/patches) ▶ Entry by Application Group ▶ Additional Components ▶ MaxDB ▶ MaxDB GUI COMPONENTS/TOOLS ▶ MAXDB DATABASE STUDIO 7.7 ▶

**Caution**
If SAP MaxDB or liveCache is installed on the PC, you must **not** install Database Studio in the same directory.

You need Java Runtime Environment (JRE) version 5 (also known as 1.5) or higher.
To check your Java version, enter the following command:
```
java -version
```

To uninstall the database manager GUI, which is the tool replaced by Database Studio, choose

- Start ▶ Settings ▶ Control Panel - ▶ Add/Remove Programs ▶

**Procedure**

1. Start the installation or upgrade as follows:
   - If you are using the MaxDB RDBMS DVD:
     `<DVD>:\MaxDB_Windows_<Processor>\SETUPS\SDBSETUP.EXE`
   - If you are using the liveCache DVD:
     `<DVD>:\LC_Windows_<Processor>\SETUPS\SDBSETUP.EXE`
   - If you are using the downloaded files, simply execute the downloaded `SDBSETUP.EXE` file.
The Installation Manager starts.
2. Choose Start Installation/Upgrade.
   An installation shield guides you through the installation.

   **Note**
   If you already have an older version installed on the PC, the installation shield offers to upgrade it for you.

3. If you are prompted to restart the PC after the installation, make sure that you first bring down any databases that are running.
5.9 Secure Sockets Layer Protocol for Database Server Communication

The SAP MaxDB database server supports the Secure Sockets Layer (SSL) protocol. You can use this protocol to communicate between the database server and its client, here the Application Server (AS). SSL guarantees encrypted data transfer between the SAP MaxDB database server and its client applications. In addition, the server authenticates itself to the client.

Caution

There is a performance cost for SSL since the data has to be encrypted, which requires time and processing power.

To use SSL you need to:

1. Install the SAP cryptographic library [page 113] on the client host and on the server host machines
2. Generate the Personal Security Environment [page 114] (PSE) on the server (SSL Server PSE) and on the client (SSL Client PSE).

5.9.1 Installing the SAP Cryptographic Library

The SAP Cryptographic Library supplies the cryptographic functions required to build a database server-client connection using Secure Sockets Layer (SSL). Therefore, you need to install the SAP Cryptographic Library on the host machine of the SAP MaxDB database server and the SAP Application Server (AS).

The installation package sapcrypto.car consists of the following:

- SAP Cryptographic Library: libsapcrypto.so/s1
- License ticket: ticket
- Configuration tool: sapgenpse.exe
  You use the configuration tool to generate key pairs and PSEs.

Caution

The SAP Cryptographic Library is subject to German export regulations and might not be available to some customers. In addition, the library might be subject to the local regulations of your country. These regulations might further restrict import, use, and export or re-export of cryptographic software.

For more information, contact your local SAP representative.

Prerequisites

Download the appropriate SAP Cryptographic Library installation package for your operating system from http://service.sap.com/swcenter.
Procedure

1. Unpack the installation package for the SAP Cryptographic Library using sapcar.exe, which you can find for example on your Installation Master DVD, using the following command:
   
   `car -xvf SAPCRYPTO.CAR`

   **Note**
   
   The remainder of the procedure (as described below) does **not** apply to client applications such as SQL Studio, which do not recognize an “independent” directory. In this case, you must copy the SAPCRYPTO installation package to the installation directory of the application. In this directory you need to create a directory `sec`, into which you copy the `ticket` file.

2. Copy the `sapcrypto` library to the `11b` subdirectory of the “independent program” directory.
   
   You can find the value of the independent program directory by entering the following command:
   
   `dbmcli dbm_getpath IndepProgPath`

   **Example**
   
   The independent program directory might be called the following:
   
   `/sapdb/programs/lib`

3. Copy the configuration tool `sapgenpse.exe` to the directory `<independent program>\lib`.

4. Create a subdirectory called `sec` under the “independent data” directory and copy the `ticket` file into it.

   **Example**
   
   The result might look like the following:
   
   `/sapdb/data/sec/ticket`

5. Make sure that the directory and the files that the `sec` directory contains— including the `ticket` file and the SSL Server PSE— belong to the user `lcmdm` and the group `lcmdm`, and that the rights are restricted to `0600`.

Result

The system copies the SAP Cryptographic Library to the application server and correctly configures the environment so that the server can find the library at runtime.

### 5.9.2 Generating the Personal Security Environment

The information required by the database server or client application to communicate using Secure Sockets Layer are stored in the Personal Security Environment (PSE). The required information differs according to whether SSL PSE is for the server or client:
SSL Server PSE
This PSE contains the security information from the database server, for example, the public-private cryptographic key pair and certificate chain. To install the SSL Server PSE, you need to generate the PSE. You can either do this for a single database server or system-wide. The SSL Server PSE is called SDBSSL.exe.

SSL Client PSE
The client requires an anonymous certificate called SDBSSLA.exe, which contains the list of the public keys of trustworthy database servers.

Procedure
To generate the SSL Server PSE, proceed as follows:

Note
You need to know the naming convention for the distinguished name of the database server. The syntax of the distinguished name, which you enter in the procedure below, depends on the Certification Authority (CA) that you are using.

1. Change to the <independent programs>\lib directory.
2. Set up the following environment variable:
   SECUDIR=<independent data>\sec
3. Create an SSL Server PSE, SDBSSL.pse, and generate a certificate request file, certreq, in the directory defined by SECUDIR (see previous step):
   sapgenpse gen_pse -v -r <SECUDIR>\certreq -p SDBSSL.pse "<your distinguished name>"
   For each database server that uses a server-specific PSE, you must set up a unique certificate request. If you are using a valid system-wide SSL Server PSE, you only need to set up a single certificate request for all servers.
4. Send the certificate request to the CA for signing. You can either send it to the SAP CA or to another CA.
   You must make sure that the CA offers a certificate corresponding to the PKCS#7 certificate chain format. Thawte CA at www.thawte.com offers a suitable certificate, either SSL Chained CA Cert or PKCS#7 certificate chain format.
   The CA validates the information contained in the certificate request, according to its own guidelines, and sends a reply containing the public key certificate.
5. After you have received the reply from the CA, make sure that the contents of the certificate request have not been destroyed during download.
   For example, if you requested the certificate on a UNIX system and stored it on a Windows front end, the formatting (that is, line indents and line breaks) is affected.
   To check the contents, open the certificate request with a text editor (such as Notepad) and repair the line indents and the line breaks.
6. Import the reply to the SSL Server PSE:
   a) Copy the text to a temporary file called srcert.
   b) Enter the following command:

   ```
   sapgenpse import_own_cert -c srcert -p SDBSSLS.pse
   ```

   You have generated the SSL Server PSE. You can now start the XServer as usual (if it is already running, you must stop and restart it).

7. To check whether the SSL functionality is working correctly, view the trace file \niserver_<local computer name>.trace in the \<independent data>\wrk directory.

To generate the SSL Client PSE, proceed as follows:

1. Change to the \<independent programs>\lib directory.
2. Set up the following environment variable:

   ```
   SECU_DIR=<independent data>\sec
   ```
3. Enter \<independent program>\lib in the environment variable LD_LIBRARY_PATH.
4. Create an anonymous client SSL Client PSE, SDBSSLA.pse in the directory defined by SECU_DIR (see previous step):

   ```
   sapgenpse gen_pse -v -noreq -p SDBSSLA.pse
   ```

   You can leave the distinguished name empty.

   Before you can establish an SSL connection to a database server, the server certificate must be entered in the PK list of the anonymous client certificate.

5. To see the database server certificate, enter the following command:

   ```
   \x_ping -n <servermode> -c[apture]
   ```

   You can check whether to trust the database server certificate. The client certificate is not affected by this.

6. Start the import with this command:

   ```
   \x_ping -n <servermode> -i[import]
   ```

7. To administer the PSE, use the configuration tool sapgenpse. For more information, enter the following command:

   ```
   sapgenpse -h
   ```

8. Note

   For applications such as SQL Studio replace the independent data or independent program in the above description with the installation directory.
5.10 Backing Up the SAP MaxDB Database

You need to define backup media and back up the SAP MaxDB database using Database Studio.

**Prerequisites**

- You have finished client maintenance.
- You have installed Database Studio [page 111].
- You can find more information on backing up the database at:
  - [https://www.sdn.sap.com/irj/sdn/maxdb](https://www.sdn.sap.com/irj/sdn/maxdb) » SAP MaxDB Knowledge Center » The Complete SAP MaxDB Documentation Set » Open the SAP MaxDB 7.7 Library » Tools » Database Studio » Backup Database: Overview

**Procedure**

1. Define the backup template as described in Defining a Backup Template in the above documentation.
2. Back up the database as described in Backing Up Data and Backing Up Log Entries in the above documentation.

5.11 Updating the Database Software to the Current Release

After the installation and before you start production operation, we strongly recommend you to update the database software.

**Procedure**

1. Download the latest MaxDB patches as follows:
   - [http://service.sap.com/swdc](http://service.sap.com/swdc) » Download » Database Patches » MaxDB
   
   For more information about upgrading to a MaxDB Support Package, see SAP Note 735598.

5.12 Post-Installation Steps for the Host Agent

You have to perform the following steps on each host where the host agent is installed. This applies whether the host agent is installed on a host within the SAP system or standalone on another host.

**Procedure**

1. You check whether the installed services are available as follows:
   a) Log on as user sapadm.
   b) Check whether the following services are available:
      - The control program saphostexec
The operating system collector `saposcol`  
The SAP NetWeaver Management agent `SAPHostControl` (`sapstartsrv` in host mode)

**Note**  
When the host is booted, the startup script `sapinit` automatically starts the required executables.

2. You configure the host agent according to your requirements.

**More Information**  
For more information, see the SAP Library [page 12]:  
▶ Function-Oriented View ▶ Application Server ABAP ▶ Administration Tools for AS ABAP ▶ Monitoring in the CCMS ▶ Infrastructure of the SAP NetWeaver Management Agents

## 5.13 Checking the SAP Java Documentation

Here you can find information in the SAP Library about the configuration of Application Server Java (AS Java) and about SAP Java technology.

**Procedure**

1. Choose the following in the SAP library [page 12]:  
▶ Function-Oriented View ▶ Application Server Java ▶ AS Java (Application Server Java)
2. Check the following documentation for information relevant to running your Java system:

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
</table>
| - Application Server Infrastructure  
  ▶ Architecture of the SAP NetWeaver Application Server  
  ▶ Architecture of AS Java | This documentation provides an overview of the architecture of the Application Server Java (AS Java). It contains information on:  
  - Java cluster architecture  
  - Application Server Java (AS Java) system architecture  
  - Zero Administration (technical configuration within AS Java) |
| - Application Server Java  
  ▶ Administration | This documentation describes how to administer the SAP system, focusing on AS Java. It contains information on:  
  - Administration Tools  
    - SAP Management Console  
      The SAP Management Console (SAP MC) provides a common framework for centralized system management. It lets you monitor and perform basic administration tasks on the SAP system centrally, thus simplifying system administration.  
    - SAP NetWeaver Administrator  
      SAP NetWeaver Administrator is a Web-based tool for administration and monitoring that offers a single entry point to configure, administer, and monitor your SAP NetWeaver system, its components, and the applications running on it. |
5.14 CE-Specific Post-Installation Activities

This section describes the steps that you have to perform after the installation has finished successfully.

Running the Configuration Wizard (Optional)

Note
You can run the configuration wizard only once and only directly after installing and patching your SAP system.

After SAPinst has finished, run the configuration wizard to apply automated configuration tasks to your system.
For SAP NetWeaver CE, you need to run the following configuration tasks, depending on the installed components:

- Configuration of Services Registry Webservice Destinations
- Configuration and Mirroring of local NWDS Update Site
5.14 CE-Specific Post-Installation Activities

- Initial setup ADS in CE (if ADS is available on your platform)
- Change Management Service (CMS): Create an Application Skeleton
- Change Management Service (CMS): Modify a Software Component

For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

**Enabling Adobe Document Services**

If you have installed SAP NetWeaver Composition Environment with the Adobe Document Services add-on a Windows platform, you must complete the following post-installation steps to enable the add-on. In case you have installed an AS Java cluster, apply the procedure to the central host, as well as to all hosts where additional application server instances are running.

1. Using the SAP Management Console, stop the AS Java system.
2. From the Start menu, open » Control Panel » Administrative Tools » Computer Management » Services and Applications » Services ».
3. Select SAP<SID>_<Instance_Number> (for example, SAPCE1_00) and open Properties from the context menu.
4. On the Log On tab page, enable the Local System account indicator.
5. Repeat the above steps for the second SAP<SID>_<Instance_Number> service that you see in the list.
6. Start the AS Java system.

**Adobe LiveCycle Designer**

For more information about how to install and configure the Adobe LiveCycle Designer see SAP Note 962763.

**Enabling Services Registry**

You must apply additional configuration steps to enable Services Registry after you have installed an SAP NetWeaver Composition Environment system containing the following components:

- Java Application Server and Composition Platform
- Java Application Server and Adobe Document Services

To enable Services Registry, you must apply the following configuration template to your system: CE_Complete_Stack_production_full
Note
For more information about what configuration templates are available, see Configuration Templates [page 127].

See also

Configuring the Portal in SAP NetWeaver CE
After installing the portal in SAP NetWeaver CE, a number of deactivated or irrelevant tools are displayed in the UI. To display the correct portals tools for CE, proceed as follows:

1. Open a browser and log on to your portal as an administrator.
2. In the same browser session, enter the following URL:
   content.layers.ContentLayersTool
   where <host> is the host name of your server and <httpport> is the port number of your server.
3. In the Portal Mode Configuration Tool, choose Activate Development Mode to restore the portal tools and content that are assigned to the development mode.
4. Restart or refresh your browser.
5. In the SAP Management Console, restart the server.

You may then continue with the mandatory and optional configuration steps as described in http://help.sap.com/nwce SAP NetWeaver Composition Environment Library | Administrator’s Guide | Configuration of SAP NetWeaver Composition Environment | Configuration for CE Additional Components | Configuring the Portal.

Changing the Password for the Internet Communication Manager (ICM)
You can monitor and manage the Internet Communication Manager (ICM) from the command line program.
After the installation of your SAP NetWeaver CE system has successfully finished, you need to change the ICM password manually. To do so, proceed as follows:

1. Log on at operating system level to the computer where the ICM is running.
2. Start the program icmon with icmon -a profile=<instance_profile> to maintain the authentication file (default: authfile.txt).
3. Choose a to add a user.
4. Choose c to change the password of the existing user.
5. Choose s to save your settings.

Further Configuration Steps
After installing your SAP NetWeaver CE system and performing the post-installation steps to get the system up & running, you may need to perform further configuration steps.
Refer to the following documentation to proceed with your tasks:

- If you are a system administrator, refer to http://help.sap.com/nwce\ Administrators Guide. It contains information about how to configure and administer your system.
- If you are a developer, refer to http://help.sap.com/nwce\ Developers Guide. It provides guidelines for developing applications using the SAP NetWeaver CE.

Note
The SAP NetWeaver CE documentation is also available offline as a part of your installation. To access it, choose Start \ All Programs \ SAP NetWeaver \ Composition Environment 1.0 \ Documentation.

5.15 Performing a Full Installation Backup

You must perform a full offline backup after the configuration of your SAP system. If required, you can also perform a full offline backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

Caution
Make sure that you fully back up your database so that you can recover it later if necessary.

You need to back up the following directories and files:

- All SAP-specific directories:
  - /usr/sap/<SAPSID>
  - /usr/sap/trans
  - <sapmnt>/<SAPSID>
  - Home directory of the user <sid>adm
- All database-specific directories
- The root file system
  This saves the structure of the system and all configuration files, such as file system size, logical volume manager configuration, and database configuration data.

Note
This list is only valid for a standard installation.
5 Post-Installation
5.15 Performing a Full Installation Backup

Prerequisites

- You have logged on [page 104] as user <sapsid>adm and stopped the SAP system and database [page 129].

This procedure works on all hardware platforms. For more information about operating system-specific backup procedures, see your operating system documentation.

Backing Up the Installation

1. Log on as user root.
2. Manually create a compressed tar archive that contains all installed files:
   - Saving to tape:
     \[
     \text{tar} \ -cf \ - \ <\text{file} \ _\text{system}> \ | \ \text{compress} \ -c \ > \ <\text{tape} \ _\text{device}>
     \]
   - Saving to the file system:
     \[
     \text{tar} \ -cf \ - \ <\text{file} \ _\text{system}> \ | \ \text{compress} \ -c \ > \ \text{ARCHIVENAME}.\text{tar}.\text{Z}
     \]

   ![Note]
   You can also execute the following command to manually create a compressed GNU tar archive that contains all installed files and save it to the file system:
   \[
   \text{tar} \ -czf \ <\text{ARCHIVENAME}>.\text{tgz} \ <\text{file} \ _\text{system}>
   \]

Restoring Your Backup

If required, you can restore the data that you previously backed up.

![Caution]
Check for modifications in the existing parameter files before you overwrite them when restoring the backup.

1. Log on as user root.
2. Go to the location in your file system where you want to restore the backup image.
3. Restore the data with the following commands:
   - From tape:
     \[
     \text{cat} \ <\text{tape} \ _\text{device}> \ | \ \text{compress} \ -cd \ | \ \text{tar} \ -xf -
     \]
   - From the file system:
     \[
     \text{cat} \ \text{ARCHIVENAME}.\text{tar}.\text{Z} \ | \ \text{compress} \ -cd \ | \ \text{tar} \ -xf -
     \]

   ![Note]
   If you want to restore the data from a GNU tar archive, you have to execute the following command:
   \[
   \text{tar} \ -xzf \ <\text{ARCHIVENAME}>.\text{tgz}
   \]
5.16 Post-Installation Steps for the Diagnostics Agent

To implement the E2E Root Cause Analysis scenario, you have to perform the following post-installation steps.

**Prerequisites**

You have installed an AS Java central instance or dialog instance.

**Procedure**

1. Upgrade the JDK on AIX and Linux x86_64 operating systems as described in SAP Note 1093831. This avoids connection problems between the Diagnostics Agent and the Diagnostics Managing system, as well as out-of-memory errors and class-loader problems.

2. Plan the implementation of the SAP Solution Manager Diagnostics Agent as described in the *Root Cause Analysis Installation and Upgrade Guide*, which you can find at one of the following:

   - [http://service.sap.com/instguides](http://service.sap.com/instguides) » SAP Components » SAP Solution Manager » <Current Release>
6 Additional Information

Here you can find additional information about the installation of your SAP system. There is also information about how to delete an SAP system.

- Mounting a CD / DVD for Linux [page 128].
- Additional Information about SAPinst [page ]
- Starting and Stopping the SAP System [page 129]
  [Only valid for: HA (UNIX)]

- High-Availability: Finalizing the enqueue replication server for high availability [page 138]. You have to perform this procedure only if you have installed the enqueue replication server (ERS) into an existing system.
  [End of: HA (UNIX)]

- Deleting an SAP System [page 139]

6.1 Transporting Self-Developed Software Component Archives (SCA) into the System

Prerequisites
You have developed your own Software Component Archives (SCA) and want to transport them into your SAP NetWeaver CE system.

Procedure
To transport your SCAs to the SAP NetWeaver CE system, proceed as follows:

2. Log on to your system as user root and, from an empty directory, run the update tool update<ID>.sh.

   Note
   If the tool displays descriptions such as Applying Support Packages, you can ignore them.

3. In the dialog screens, specify the directory where your SCAs are located.
4. Follow the on-screen instructions.
6.2 Troubleshooting – Repairing an Inconsistent SAP MaxDB Installation

Prerequisites
During the preinstallation phase, the installation tool checks the Microsoft Windows registry for already installed SAP MaxDB software. If the registry key is found but there is no software on the hard drive, you receive the following message:

*The existing MaxDB software is not consistent. Check the file system and registry.*

The most common reason for this inconsistency is the manual deletion of the software from the file system without using the specified tools.

Procedure
To repair this inconsistency, proceed as follows:

1. Choose \Start\ Control Panel \Administrative Tools \Services.
2. Make sure the services SAPDBWWW, SAPDB: *, and XServer are stopped.
3. Choose \Start \ Run and run the command `regedit`.
4. Go to \My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAP DBTech \ Key IndepPrograms.
   The key contains a path to a folder.
   a) Check if this folder exists on the file system.
   b) Note down the value of `Key IndepPrograms` for later usage (see step 7).
   If the path does not exist in the file system, delete the key SAP DBTech.
5. Delete the following keys:
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SAP DBTech.*
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SAPDBWWW
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\XServer
6. Choose \Start \ Control Panel \ System \ Advanced \ Environment Variables \ System Variables \ Path.
7. Delete the following paths from the variable:
   - <IndepPrograms>/bin
   - <IndepPrograms>/pgm
8. Reboot your computer.

6.3 Restarting the SAP MaxDB Server Manually

If, after a reboot, the database server is not running automatically, you need to restart the SAP MaxDB server manually.

Production Systems
To restart the SAP MaxDB server manually, proceed as follows:
1. Open a command prompt and enter the following command: `net start sapdbwww` OR
   Choose Start ➤ All Programs ➤ Administrative Tools ➤ Services. Double-click on SAP DB WWW and choose Start.
2. Open the SAP Management Console and choose SAP Systems ➤ <SAPSID> ➤ <machine name> ➤.
3. Enter the master password and choose Logon.
4. Choose Online. When the database server is online, you can restart the engine.

**Development Systems**

To restart the SAP MaxDB server manually, choose Start ➤ All Programs ➤ SAP NetWeaver Composition Environment CE ➤ Application Server <SAPSID> ➤ Start Application Server ➤.

### 6.4 Configuration Templates

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options. The following table provides information about the available templates with SAP NetWeaver Composition Environment. In the template name, replace the `<system_mode>` parameter by development (for the templates relevant to systems installed in development mode) or production (for the templates relevant to systems installed in productive mode).

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Selected Installation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Java EE_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation</td>
</tr>
<tr>
<td>CE_Composition_Environment_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation</td>
</tr>
<tr>
<td>CE_Adobe_Document_Service_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Adobe Document Services Add-on Installation</td>
</tr>
<tr>
<td>CE_Composite_Voice_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Voice Add-on Installation</td>
</tr>
<tr>
<td>CE_Complete_Stack_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation + Adobe Document Services Add-on Installation + Voice Add-on Installation</td>
</tr>
</tbody>
</table>

If your selection cannot be mapped to one of the combinations in the above table, the template `CE_Complete_Stack_<system_mode>_full` is applied. It starts all applications and services needed to run the complete stack.
You can manually apply a different configuration template if you want to switch to another installation option. For example, by changing from template CE_Complete_Stack_<system_mode>_full to CE_Java_EE_<system_mode>_full, you achieve shorter startup times and less memory consumption, but also less functionality since not all applications and services are running.

For more information about applying configuration templates, see http://help.sap.com/nwce Administrator’s Guide | Configuration of SAP NetWeaver CE | Initial System Configuration | AS Java Configuration | Activating a Configuration Template.

Note
Make sure that you do not apply a development template to a productive system or vice versa.

6.5 Uninstalling SAP NetWeaver Composition Environment

You have to uninstall all components of the SAP NetWeaver Composition Environment separately. You can uninstall your SAP NetWeaver CE system in different ways.

Uninstalling SAP NetWeaver CE
Start the uninstallation from the directory /usr/sap/SID/SYS/exe/uc/<platform>/uninstall.

Uninstalling SAP NetWeaver CE Using SAPInst
1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPInst from the SAP Installation Master DVD as described in the section Installing SAP NetWeaver Composition Environment.
3. In the Welcome screen, choose Uninstall SAP System or Single Instances from the tree structure.
4. Follow the on-screen instructions.

6.6 Mounting a CD / DVD for Linux

You can use this procedure to mount a CD or DVD.

Note
The placeholder <medium-mountdir> is used for either <cd-mountdir> or <dvd-mountdir>.

Procedure
1. Log on as user root.
2. To create a mount point for the CD / DVD, enter the following command:
   ```
   mkdir <medium-mountdir>
   ```
Additional Information

6.7 Heterogeneous SAP System Installation

Example

```bash
<medium-mountdir> is /sapcd
```

3. To mount the first CD / DVD device, enter the following command:

```bash
mount -t iso9660 -r <device> <medium-mountdir>
```

where `<device>` is `/dev/cdrom` for non-SCSI CD devices and `/dev/scd<n>` for SCSI drives with the device number `<n>`. If the file names on the mounted CD / DVD are written in lowercase letters, remount the CD / DVD with the following commands:

```bash
umount <device>
mount -t iso9660 -r -o map=off <device> <medium-mountdir>
```

6.7 Heterogeneous SAP System Installation

This section provides information on the installation of an SAP system in a heterogeneous system landscape. “Heterogeneous system landscape” means that application servers run on different operating systems.

**Procedure**

See SAP Note 1067221 for information on

- supported combinations of operating systems and database systems,
- how to install an application server on Windows in a heterogeneous (UNIX) SAP system environment,
- heterogeneous SAP system landscapes with different UNIX operating systems.

6.8 Starting and Stopping SAP System Instances

You can start and stop SAP system instances and the Diagnostics Agent by using the SAP Management Console (SAP MC) [page 129]. Apart from using the SAP Management Console (SAP MC) you can also use scripts to:

- Start or stop SAP system instances [page 133]
- Start or stop the Diagnostics Agent [page 137].

6.8.1 Starting and Stopping the SAP System Using the SAP Management Console

You can start and stop all instances of your SAP system using the SAP Management Console (SAP MC).
Note

If your newly installed SAP system is part of a heterogeneous SAP system landscape comprising systems or instances on Windows platforms, you can also start and stop it from a Windows system or instance using the Microsoft Management Console (MMC).

For more information about handling the MMC, see the SAP Library [page 12]:

- Function-Oriented View → Application Server ABAP → Administration Tools for AS ABAP → Monitoring in the CCMS → SAP Microsoft Management Console: Windows

Prerequisites

- Make sure that the host on which you start SAP MC meets the following requirements:
  - Java Runtime Environment (JRE) 5.0 is installed.
  - The browser supports Java.
  - The browser’s Java plug-in is installed and activated.
- You have logged on to the host as user <sapsid>adm.

Starting the Web-Based SAP Management Console

1. Start a Web browser and enter the following URL:

   \[http://<hostname>:<instance_number>13\]

   **Example**

   If the instance number is 53 and the host name is saphost06, you enter the following URL:

   \[http://saphost06:55313\]

   This starts the SAP MC Java applet.

   **Note**

   If your browser displays a security warning message, choose the option that indicates that you trust the applet.

2. Choose Start.

   The SAP Management Console appears.

   **Note**

   When you start the SAP MC for the first time for a newly installed SAP system, you have to register your system as described in Registering Systems and Instances below. Having done this, the instances installed on the host you have connected to are already added in the SAP Management Console when you start the SAP MC next time.

   By default, the instances installed on the host you have connected to are already added in the SAP Management Console.
If you want to change the configuration to display systems and instances on other hosts, see Registering Systems and Instances below.

Starting and Stopping Systems and Instances

Starting an SAP System or Instance

1. In the navigation pane, open the tree structure and navigate to the system node that you want to start.
2. Select the system or instance and then, from the context menu, choose Start.
3. In the Start SAP System(s) dialog box, choose the required options.
4. Choose OK. The SAP MC starts the specified system or system instances.

Note

The system might prompt you for the SAP system administrator credentials. To complete the operation, you must have administration permissions. Log in as user <sapsid>adm.

Starting Instances Separately

If you need to start the instances of an SAP system separately, for example when you want to start a distributed or a high-availability system, proceed in the following sequence:

1. Start the database instance.
2. Start the central services instance SCS<Instance_Number>.
3. Start application server instance(s) J<Instance_Number>.

Stopping an SAP System or Instance

1. Select the system or instance you want to stop and choose Stop from the context menu.
2. In the Stop SAP System(s) dialog box, choose the required options.
3. Choose OK. The SAP MC stops the specified system or system instances.

Note

The system might prompt you for the SAP system administrator credentials. To complete the operation, you must have administration permissions. Log in as user <sapsid>adm.

Similarly, you can start, stop or restart all SAP systems and individual instances registered in the SAP MC.

Stopping Instances Separately

If you need to stop the instances of an SAP system separately, for example when you want to start a distributed or a high-availability system, proceed in the following sequence:

1. Stop application server instance(s) J<Instance_Number>. 
2. Stop the central services instance SCS<Instance_Number>.
3. Stop the database instance.

**Registering Systems and Instances in the SAP Management Console**
You can extend the list of systems and instances displayed in the SAP MC, so that you can monitor and administer all systems and instances from a single console. You can configure the SAP MC startup view to display the set of systems and instances you want to manage.

**Prerequisites**
The SAP MC is started.

**Registering SAP Systems**
1. In the SAP MC, choose File > New.
2. In the New System dialog box, enter the required data.

**Note**
If you have already registered systems in the SAP MC, they are stored in the history. To open the System's History dialog box, choose the browsing button next to the Instance Nr. field. Select an instance of the system that you want to add and choose OK.

3. Choose Finish.

**Registering Individual Instances**
1. In the SAP MC, choose File > New.
2. In the New System dialog box, enter the required data and deselect Always show all SAP Instances.
3. The SAP MC displays the SAP system node, the instance node and the relevant database node in a tree view in the navigation pane.

**Note**
To view all instances of the respective SAP system, select the relevant system node and choose Add Application Server from the context menu.

**Configuring the SAP MC View**
- You can choose the instances that the SAP MC displays automatically on startup:
  1. In the Settings dialog box, select History.
  2. In the right-hand side pane, choose the instance you want the SAP MC to display on startup.
  3. Choose the << button.
  4. Choose Apply and then choose OK.
     Similarly, you can remove instances from the startup configuration.
- You can save the current configuration in a file:
1. Choose File ▶ Save Landscape.
2. In the Save dialog box, enter the required data.
3. Choose Save.

You can load a configuration from a file:
1. Choose File ▶ Load Landscape.
2. In the Open dialog box, select the configuration you want to load.
3. Choose Open.

More Information
For more information about how to handle the SAP MC, see the SAP Library [page 12]:

6.8.2 Starting and Stopping the SAP System Using Scripts

You can start and stop the SAP system by running the startsap and stopsap scripts.

Prerequisites
You have checked the default profile /<sapid>/<SAPSID>/profile/DEFAULT.PFL for parameter login/system_client and set the value to the correct productive system client. For example, the entry must be login/system_client = 001 if your productive client is 001.
You have logged on to the SAP system hosts as user <sapid>adm.
For more information about how to start or stop database-specific tools, see the database-specific information in this documentation and the documentation from the database manufacturer.
If you want to use startsap or stopsap (for example, in a script) and require the fully qualified name of these SAP scripts, create a link to startsap or stopsap in the home directory of the corresponding user.

⚠️ Caution
If there are multiple SAP instances on one host – for example, a primary application server instance and an additional application server instance – you must add an extra parameter to the scripts:

```
startsap <instanceID>
stopsap <instanceID>
```
For example, enter:
```
startsap J00
```
6.8 Starting and Stopping SAP System Instances

Note
The instance name (instance ID) of the primary application server instance is J<Instance_Number>, the instance name of the central services instance is SCS<Instance_Number>, and the instance name of a Java additional application server instance is J<Instance_Number>.

Only valid for: HA (UNIX)

In a high-availability system, you must use the failover cluster software of your hardware vendor to start or stop all instances that are running on the switchover cluster. You can only use startsap and stopsap scripts for instances that are not running on the switchover cluster.

End of: HA (UNIX)

Procedure

Starting the SAP system

To start all instances on the standard system host, enter the following command:

```
startsap
```
This checks if the database is already running. If not, it starts the database first.

Note
You can start the database and SAP system separately by entering the following commands:

```
startsap DB
startsap R3 <instance ID of central services instance>
startsap R3 <instance ID of primary application server instance>
startsap R3 <instance ID of additional application server instance>
```
Make sure that you always start the database first because otherwise the other instances cannot start.

Note
You can also use the parameter J2EE, which is a synonym for the parameter R3. For ABAP+Java systems, you can enter either the command startsap R3 or startsap J2EE to start the SAP instance comprising both ABAP and Java.

In a distributed system, proceed as follows:

1. On the host running the database instance, enter:

```
startdb
```
2. On the host running the central services instance, enter:

```
startsap
```
3. On the host running the primary application server instance, enter:

```
startsap
```
4. For additional application server instance(s), enter the following on the relevant host:

```
startsap R3 <instance ID of additional application server instance>
```

Note
Make sure that the SAP system is up and running before you start or restart additional application server instances.

- **In a high-availability system**, proceed as follows:

Note
In the following example, only the central services instance is running on the switchover cluster.

1. On the database host, enter:

```
startdb
```

2. On the switchover cluster infrastructure, use the failover cluster software to start the central services instance.

3. On the host of the primary application server instance, enter:

```
startsap
```

4. For additional application server instance(s), enter the following on the relevant host:

```
startsap R3 <instance ID of additional application server instance>
```

Note
Make sure that the SAP system is up and running before you start or restart additional application server instances.

- **For an additional application server instance**, enter the following on the relevant host:

```
startsap R3 <instance ID of additional application server instance>
```

Note
Make sure that the SAP system is up and running before you start or restart additional application server instances.

**Stopping the SAP System**

Note
When you use `stopsap` in a Multiple Components in One Database (MCOD) system with two primary application server instances, only one primary application server instance and the database are shut down. Therefore, you must first stop the other SAP system with `stopsap R3` or make sure that it has already been stopped.

For more information, see *Installation of Multiple Components in one Database* [page 3].
If you have a **standard system**, enter the following to stop all instances on the standard system host:

```yaml
stopsap
```

This stops the primary application server instance, central services instance, and database.

**Note**

You can stop the database and SAP system separately by entering the following commands:

```yaml
stopsap R3 <instance ID of additional application server instance>
stopsap R3 <instance ID of primary application server instance>
stopsap R3 <instance ID of central services instance>
stopsap DB
```

Make sure that you always stop the primary application server instance first and the central services instance second because otherwise the database cannot be stopped.

**Note**

You can also use the parameter J2EE, which is a synonym for the parameter R3. For ABAP+Java systems, you can enter either the command `stopsap R3` or `stopsap J2EE` to stop the SAP instance comprising both ABAP and Java.

**In a distributed system**, proceed as follows:

1. On the host(s) running the additional application server instance(s), enter the following command:

   ```yaml
   stopsap <instance ID of additional application server instance>
   ```

2. On the host running the primary application server instance, enter:

   ```yaml
   stopsap
   ```

3. On the host running the central services instance, enter:

   ```yaml
   stopsap
   ```

4. On the host running the database instance, enter:

   ```yaml
   stopdb
   ```

**In a high-availability system**, proceed as follows:

**Note**

In the following example, only the central services instance is running on the switchover cluster.

1. On the host(s) running the additional application server instance(s), enter the following command:

   ```yaml
   stopsap <instance ID of additional application server instance>
   ```

2. On the host running the primary application server instance, enter:

   ```yaml
   stopsap
   ```
6.8 Starting and Stopping SAP System Instances

3. On the switchover cluster infrastructure, use the failover cluster software to start the central services instance.
4. On the host running the database instance, enter:
   - `stopdb`
   - For an additional application server instance, enter the following on the relevant host:
     - `stopsap R3 <instance ID of additional application server instance>`

**Note**
Make sure that the SAP system is up and running before you start or restart additional application server instances.

**Caution**
Make sure that no SAP instance is running before you enter `stopdb` on a standalone database server. No automatic check is made.

### 6.8.3 Starting and Stopping the Diagnostics Agent Using Scripts

You can start and stop the Diagnostics Agent by running the `smdstart` and `smdstop` scripts.

The local versions of these scripts are located in `/usr/sap/<SMDSID>/J<Instance_Number>/script`. The global versions of these scripts are located in `/usr/sap/<SMDSID>/exe`.

**Note**
You can only start or stop the Diagnostics Agent separately. It is not started or stopped automatically with the SAP system.

You can also use the *SAP Management Console (SAP MC)* [page 129] to start or stop the Diagnostics Agent.

**Prerequisites**
You have logged on to the central instance or dialog host as user `<smdsid>adm`.

**Procedure**

**Starting a Diagnostics Agent Locally**

1. Change to the following directory:
   - `/usr/sap/<SMDSID>/J<Instance_Number>/script`
2. To start the Diagnostics Agent locally, enter this command:
   - `./smdstart.sh`
Starting Diagnostics Agent(s) Globally

To start Diagnostics Agent(s) globally, enter this command:

`smdstart <SMDSID> <Instance_Number>`

**Example**

`smdstart SMD 98`

**Note**
You do not have to specify the `<SMDSID>` if there is only one Diagnostics Agent system on this host.

Stopping a Diagnostics Agent Locally

1. Change to the following directory:
   `/usr/sap/<SMDSID>/J<instance_number>/script`
2. To stop the Diagnostics Agent locally, enter this command:
   `./smdstop.sh`

Stopping Diagnostics Agent(s) Globally

To stop Diagnostics Agent(s) globally, enter this command:

`smdstop <SMDSID> <Instance_Number>`

**Example**

`smdstop SMD 98`

**Note**
You do **not** have to specify the `<SMDSID>` if there is only one Diagnostics Agent system on this host.

---

**6.9 High Availability: Finalizing the Enqueue Replication Server**

You have to perform this procedure only if you have installed the enqueue replication server (ERS) into an existing system. This is necessary to ensure correct functioning of the ERS, which depends on the switchover software you are using.

**Procedure**

1. Restart the central services instance associated with the ERS.
   This requires you to restart the primary application server and additional application server instance.
2. Contact your hardware partner to configure and test the ERS.

**More Information**

See the SAP Library [page 12] ▶ Function-Oriented Overview ▶ Application Server Infrastructure ▶ Standalone Enqueue Server ▶ Installing the Standalone Enqueue Server ▶

End of: HA (UNIX)

### 6.10 Deleting an SAP System

This section describes how to delete a single instance, a standalone engine or a complete SAP system with the *Uninstall* option of SAPinst.

⚠️ **Caution**

- You cannot delete an SAP system remotely.
- If you delete network-wide users, groups or service entries in an environment with Network Information System (NIS), other SAP installations might also be affected. Make sure that the users, groups, and service entries to be deleted are no longer required.

**Prerequisites**

- This description assumes that you have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on as user *root*.
- If the *saposcol* process on the host where you are working has been started from the SAP system that you want to delete, stop the process using the command `saposcol -k`.

If there are other SAP systems on the host, log on as user `<sapsid>adm` of the other SAP system and start *saposcol* from there using the command `saposcol -I`.

**Procedure**

1. Start *SAPinst* [page 89] and on the *Welcome* screen, choose:
2. Follow the instructions in the SAPinst input dialogs.

⚠️ **Note**

For more information about the input parameters, place the cursor on the relevant field and press **F1** in SAPinst.

SAPinst first asks you which SAP instances you want to delete. Make sure that you delete the SAP instances in the order as described hereinafter.
If you want to delete a **standard** system (all instances reside on the same host), you can do this in one SAPinst run.

If you want to delete a **distributed** system, you have to run SAPinst to delete the required instances **locally** on each of the hosts belonging to the SAP system in the following sequence:

a) Additional application server instance(s), if there are any
b) Database instance

g) **Caution**

SAPinst only stops **local** instances automatically. Before you delete the database instance of a distributed system make sure that you stop all remaining instances. You must stop the instance with the message server only after having entered all SAPinst parameters for the deletion of the database instance.

Choose whether you want to drop the entire database or only one or more database schemas. If you drop the entire database, SAPinst also asks whether you want to remove the database software.

c) Primary application server instance
d) Central services instance

**Note**

To delete system directories mounted from an NFS server, make sure that you run SAPinst on the NFS server.

3. If required, you can delete the directory `/usr/sap/trans` and its content manually.

   SAPinst does not delete `/usr/sap/trans` because it might be shared.

4. If you created the directories `/usr/sap/<SAPSID>` and `/<sapmnt>/<SAPSID>` as mount points, but not as directories on the local file system, you have to remove them manually.
## Typographic Conventions

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt; &gt;</code></td>
<td>Angle brackets indicate that you replace these words or characters with appropriate entries to make entries in the system, for example, “Enter your <code>&lt;User Name&gt;</code>”.</td>
</tr>
<tr>
<td>Arrows</td>
<td>Arrows separating the parts of a navigation path, for example, menu options</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters that you enter in the system exactly as they appear in the documentation</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Textual cross-references to an internet address, for example, <a href="http://www.sap.com">http://www.sap.com</a></td>
</tr>
<tr>
<td><code>/example</code></td>
<td>Quicklinks added to the internet address of a homepage to enable quick access to specific content on the Web</td>
</tr>
<tr>
<td><strong>123456</strong></td>
<td>Hyperlink to an SAP Note, for example, SAP Note 123456</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters quoted from the screen. These include field labels, screen titles, pushbutton labels, menu names, and menu options.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Cross-references to other documentation or published works</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Output on the screen following a user action, for example, messages</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Source code or syntax quoted directly from a program</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>File and directory names and their paths, names of variables and parameters, and names of installation, upgrade, and database tools</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, database table names, and key concepts of a programming language when they are surrounded by body text, for example, <code>SELECT</code> and <code>INCLUDE</code></td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard</td>
</tr>
</tbody>
</table>
© Copyright 2008 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Excel, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.

IBM, DB2, DB2 Universal Database, OS/2, Parallel Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400, iSeries, pSeries, xSeries, zSeries, System i, System i5, System p, System p5, System x, System z, System z9, z/OS, AFP, Intelligent Miner, WebSphere, Netfinity, Tivoli, Informix, i5/OS, POWER, POWERS, POWERS+, OpenPower and PowerPC are trademarks or registered trademarks of IBM Corporation.

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Oracle is a registered trademark of Oracle Corporation.

UNIX, X/Open, OSF/1, and Motif are registered trademarks of the Open Group.

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

Java is a registered trademark of Sun Microsystems, Inc.

JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, R/3, xApps, xApp, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP Business ByDesign, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.

These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies ("SAP Group") for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

This document was created using stylesheet 2006-12-31 (V5.1beta [= 6.0 for E3]) and XSLT processor SAXON 6.5.2 from Michael Kay (http://saxon.sf.net/), XSLT version 1.
Disclaimer
Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components. Any Java™ Source Code delivered with this product is only to be used by SAP’s Support Services and may not be modified or altered in any way.

Legal Software Terms

Terms for Included Open Source Software
This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. This software was developed using ANTLR.
2. SAP License Agreement for STLport
SAP License Agreement for STLPort between
SAP Aktiengesellschaft
Systems, Applications, Products in Data Processing
Dietmar-Hopp-Allee 16
69190 Walldorf, Germany
(hereinafter: SAP)
and
you
(hereinafter: Customer)
a) Subject Matter of the Agreement
   A) SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLport.org C++ library
   (STLport) and its documentation without fee.
   B) By downloading, using, or copying STLport or any portion thereof Customer agrees to abide by the intellectual
   property laws, and to all of the terms and conditions of this Agreement.
   C) The Customer may distribute binaries compiled with STLport (whether original or modified) without any
   royalties or restrictions.
   D) Customer shall maintain the following copyright and permissions notices on STLPort sources and its
   documentation unchanged: Copyright 2001 SAP AG
   E) The Customer may distribute original or modified STLPort sources, provided that:
      ■ The conditions indicated in the above permissions notice are met;
      ■ The following copyright notices are retained when present, and conditions provided in accompanying
        permission notices are met:
        Copyright 1994 Hewlett-Packard Company
        Copyright 1996,97 Silicon Graphics Computer Systems Inc.
        Copyright 1997 Moscow Center for SPARC Technology.
        Copyright 1999,2000 Boris Fomitchev
        Copyright 2001 SAP AG
   Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is
   hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
   copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company
   makes no representations about the suitability of this software for any purpose. It is provided “as is” without
   express or implied warranty.
   Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is
   hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Boris Fomichev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice. Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

b) Support and Maintenance
SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.

All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

c) Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights.

Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

d) Limited Liability
A) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.
B) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.
C) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.
D) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.
E) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.
F) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and / or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 854621.

**Documentation in the SAP Service Marketplace**

You can find this document at the following address: [https://service.sap.com/instguides](https://service.sap.com/instguides)